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Objectifs

L'objectif principal de ce cours est d'apprendre aux étudiants a maitriser les outils et commandes de base
nécessaires pour le calcul automatique des structures de batiments, grace a 1'apprentissage des fonctions
essentielles du logiciel ETABS.

A la fin de cette formation, 1'étudiant devrait étre capable de :

* Naviguer dans l'interface utilisateur d'ETABS de maniére autonome ;

¢ Utiliser les fonctions fondamentales du logiciel ETABS ;

¢ Utiliser les outils de dessin pour la conception des structures ;

* Appliquer les charges statiques et sismiques tout en respectant les réglements en vigueurs ;
* Evaluer le comportement statique et dynamique de batiments multi-étagés en béton armé.
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PRE-REQUIS

PRE-REQUIS

Une bonne maitrise de 1'environnement Windows et du dessin technique sont un atout, mais il
n'est pas nécessaire d'avoir de connaissances en ETABS au préalable.
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PEDAGOGIE

PEDAGOGIE

Apports théoriques avec support de cours étayés par de nombreux exercices pratiques et une
évaluation des acquis en fin de formation.

Ce cours est approprié pour toutes les spécialités du domaine de génie civil.

Il n'est pas prévu dans le cadre de cette formation de s'étendre sur les techniques de
modélisation des ouvrages spéciaux (silos, les structures métalliques ... etc.), cependant une
approche sera envisagée si le temps nous le permet.
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INTRODUCTION

INTRODUCTION

A 1'heure actuelle, on dispose de nombreux programmes basés sur la méthode des éléments finis
(MEF) permettant le calcul automatique de structures diverses. L'ingénieur pourrait donc
ignorer les principes de la MEF, il lui suffirait de savoir utiliser les programmes de calcul et de
connaitre les réglements en vigueurs. Seulement, cet utilisateur serait incapable de se rendre
compte de la correction des résultats donnés par l'ordinateur.

Il est donc indispensable que tout ingénieur connaisse les bases de la MEF, et comprenne
également le processus de la phase de solution. Cette compétence ne peut étre acquise que par
I'étude analytique du concept de la MEF et la connaissance des techniques en rapport avec
'utilisation de ces outils de calcul.

Cette formation se fixe comme objectif la présentation des notions fondamentales du calcul
automatique d'un point de vue essentiellement physique tout en considérant le code de calcul
dans son efficacité opératoire, c'est a dire en tant qu'outil destiné a 1'utilisateur professionnel.

Ce dernier pourra alors en tenant compte des considérations précédentes, formuler son probléme
de calcul de structure et controler sans effort les résultats fournis par l'ordinateur.

La MEF est une généralisation de la méthode de déformation pour les cas de structures ayant
des éléments barres, plans ou volumineux. La méthode considére le milieu solide, liquide ou
gazeux constituant la structure comme un assemblage discret d'éléments finis. Ces derniers sont
connectés entre eux par des nceuds situés sur les limites de ces éléments. Les structures réelles
sont définies par un nombre infini de noeuds.

La structure étant ainsi subdivisée, elle peut étre analysée d'une maniére similaire a celle utilisée
dans la théorie des poutres. Pour chaque type d'éléments, une fonction de déformation (fonction
de forme) de forme polynomiale qui détermine la relation entre la déformation et la force nodale
peut étre dérivée sur la base de principe de 1'énergie minimale, cette relation est connue sous le
nom de la matrice de rigidité de 1'élément. Un systéme d'équation algébrique linéaire peut étre
établi en imposant 1'équilibre de chaque nceud, tout en considérant comme inconnues les
déformations aux nivaux des noeuds. La solution consiste donc & déterminer ces déformations,
en suite les forces et les contraintes seront calculées en utilisant les matrices de rigidité de
chaque élément.
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CHAPITRE .I. INTRODUCTION GENERALE ET DEFINITIONS

CHAPITRE .I.
INTRODUCTION
GENERALE ET
DEFINITIONS

Définition du Calcul de Structures Assisté par Ordinateur "C.S.A.O."
Composants d'un logiciel C.S.A.O.
Description de l'outil CAO utilisé

Description de l'ouvrage étudié
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Etapes de la modélisation

Ce chapitre présente le contexte et le domaine d'intérét de cette formation. Nous consacrons la
premiére partie de ce chapitre a la présentation de la technique de Calcul de Structures Assisté par
Ordinateur (C.S.A.O.) ot nous abordons les enjeux et les avantages qui sont attendus lors de son
utilisation. Dans un second temps, nous soulignons les différentes étapes employées dans la
modélisation des structures par CSI ETABS. Finalement, nous nous focalisons sur la présentation
du probléme traité et ses différentes propriétés afin de le concevoir.

1. Définition du Calcul de Structures Assisté par Ordinateur
"C.S.A.0."

La technologie de la Conception Assistée par Ordinateur C.A.O. a pris naissance au sein des
grands programmes militaires américains dans les années 1950. Ensuite, elle a pénétré le
domaine de 1'aéronautique civile, 'automobile, 1'industrie informatique, I'architecture et le génie
civil.

Nous pouvons distinguer plusieurs générations de systémes de C.A.O. qui peuvent étre
classifiées, d'un point de vue historique, de la maniére suivante :

1. Le Dessin Assisté par Ordinateur (D.A.O.): les objets sont représentés par la projection
de leurs arétes sur un plan bidimensionnel 2D ;

2. La représentation dite fil de fer ( Wireframe): les objets sont représentés par ses arétes
mais dans l'espace tridimensionnel 3D ;

3. La représentation des objets par leurs frontiéres surfaciques ;

4. La représentation par l'espace tridimensionnel occupé par 1'objet, cette génération est
appelée 1'arborescence de construction.

/@ Définition

Nous pouvons définir le Calcul de Structures Assisté par Ordinateur (C.S.A.O.) par l'ensemble
des outils logiciels et des techniques informatiques qui permettent d'assister les concepteurs dans
la conception et la mise au point d'un produit.
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CHAPITRE .I. INTRODUCTION GENERALE ET DEFINITIONS

2. Composants d'un logiciel C.S.A.O.

Un logiciel de C.S.A.O. se compose généralement de quatre parties majeures qui peuvent étre
organisées comme suit :

* Le modeleur géométrique : il représente "la planche a dessin". Nous trouvons dans
cette partie les composants géométriques essentiels qui permettent le dessin de la
géométrie de la structure: points, droites (poutres et poteaux), éléments plans (planchers
et voiles) ... etc. Il intégre également les composants topologiques: orientations,
intersections, unions ... etc ;

¢ L'outil de visualisation : il représente 1'espace de dessin ;

¢ Un certain nombre d'applications : nous retrouvons les différents types de systémes
de chargement (concentrés, surfaciques, volumiques), les fonctions qui permettent
'introduction des systémes de chargement dynamique (spectre de réponse), les conditions
aux limites (diaphragme et appuis), I'exécution du probléme ... etc ;

* Un contréleur : il gére et manipule les intersections entre les trois outils cités
précédemment. Ce composant permet la détection des erreurs de modélisation des
structures.

3. Description de l'outil CAO utilisé

Dans le cadre de notre travail, nous utilisons CSI ETABS 9.7.0 pour la modélisation et le calcul
automatique des structures. Le programme ETABS (Exztended Three-dimensional Analysis of
Building Systems) est un logiciel leader en ingénierie des structures, créé en 1984 et édité par
Computers & Structures Inc.

Ce logiciel, qui en est a sa quinziéme édition, est fréquemment utilisé par les ingénieurs civils
pour le calcul tridimensionnel par éléments finis de batiments et des ouvrages de génie civil.

Les principales raisons d'utilisation de ce programme comme un outil de calcul de structures,
est qu'il est utilisé pour analyser les structures en béton armé, charpente métallique ou autres
matériaux de construction et sous n'importe quelle forme de chargement (ponctuel, linéaire,
surfacique... etc.). Le logiciel traite plusieurs types de chargement statique (poids propre de la
structure et charges d'exploitation) ou dynamique (séisme). De plus, il dispose de plusieurs
réglages pour les différentes vérifications : Eurocode, réglements américains et autres.

Le post-processeur graphique du logiciel facilite considérablement :

1. La modélisation des géométries complexes de structures (définition de la géométrie,
conditions aux limites, chargements de la structure,... etc.) de facon totalement
graphique, numérique ou combinée, en utilisant les innombrables outils disponibles ;

2. L'interprétation et l'exploitation des résultats se clarifient par la possibilité de visualiser :
la déformée de la structures, les diagrammes des efforts et courbes enveloppes, les champs
de contraintes, les modes propres de vibration, le centre de masse et le centre de rigidité,
les déplacements inter-étages, la résultante des forces pour des éléments spécifiés,... etc ;

3. La mise en forme des notes de calcul et des rapports explicatifs sur la base de différents
réglements.

Les fichiers produits par ETABS portent l'extension " EDB ". Le logiciel n'est pas disponible
en francais et il ne donne pas les schémas de coffrage et ferraillage pour les éléments en béton
armé.

4. Description de l'ouvrage étudié

Notre projet consiste a étudier un batiment a usage d'habitation, composé d'un
Rez-De-Chaussée et 5 étages identiques avec une terrasse inaccessible entourée par un
acrotére en béton armé de 60 cm de hauteur. Cet immeuble sera implanté a la wilaya de
Constantine, cette région est classée comme une zone de moyenne sismicité (zone Il.a) selon la
classification des zones établie par le réglement parasismique Algérien 99 version 2003. Le
batiment étudié présente les caractéristiques suivantes :

® Selon la classification des ouvrages suivant leur importance d'aprés le réglement
parasismique Algérien, le groupe d'usage est le "groupe 2" ;
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CHAPITRE .I. INTRODUCTION GENERALE ET DEFINITIONS

® Selon la zone sismique et le groupe d'usage du batiment, le coefficient d'accélération de
zone "A" est égal 4 0.15 ;

* Le contreventement de la structure est assuré par des voiles porteurs, d’ou la valeur
du coefficient de comportement "R" est égale a 3.5 ;

* La structure étudiée présente une régularité en plan et en élévation ;

* La configuration du batiment étudié ne satisfait pas les conditions minimales sur
les files de contreventement et la redondance en plan ;

® Des essais systématiques sur les matériaux mis en ceuvre seront réalisés par l'entreprise
pour contrdler la qualité des matériaux utilisés ;

® Une mission de suivi sur chantier sera effectuée pour contréler la qualité d'exécution
des travaux ;

® Selon les critéres de qualité, le facteur de qualité Q vaut 1,1 ;

Selon 1'étude géotechnique, le sol est classé dans la catégorie S3 (sol meuble) ;

Le pourcentage d'amortissement critique € est égal & 7% ;

L'acier utilisé est de nuance Fe E 400 ;

Le béton utilisé est le B25 ;

Les planchers utilisés sont des planchers en corps creux (16+44) cm.

Les balcons sont des dalles pleines de 15 cm d'épaisseur ;

La section des poteaux (POT30x45) est égale & 30x45 cm? ;

Les voiles ont une épaisseur de 20 cm et de longueur de 2m ;

Les poutres porteuses (PP30x45) agissent dans la direction x-x et ont une section

de 30x45 cm? ;

* Les poutres de chainages (PCH30x40) agissent dans la direction y-y et ont une
section de 30x40 cm? ;

® Selon le Document Technique Réglementaire DTR BC 2.2 charges permanentes et
charges d'exploitation, la charge d'exploitation est égale a 0.15 t/m? pour l'étage
courant, 0.1 t/m? pour le plancher de terrasse et 0,35 t/m? pour les balcons ;

* L'acrotére est considéré comme une charge permanente de 0.1 t/ml ;

* Les dimensions en plan et en élévation du batiment étudié sont illustrées par les figures

1.1 et L.2.

:

(5)
(3

085

y 3,30 1,00 | 4,65 ; 310 ’ 4,65 100 3,30

Figure 1.1. Vue en plan du bdtiment.
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Figure 1.2. Vues en élévation et en 3D du bdtiment.

5. Etapes de la modélisation

La modélisation sur ETABS consiste en les étapes suivantes :

1.
2.
3.

R N DO

Initialiser le modéle (unités, grilles, niveaux) ;

Définir la géométrie du modéle ;

Définir les parameétres de l'analyse (matériaux, sections ... etc) et les assigner aux
éléments ;

Spécifier les conditions aux limites (appuis et les diaphragmes) ;

Définir les cas de charge (Statique et dynamique) et les appliquer aux éléments ;

Spécifier les options d'analyse (options de 1'analyse modale) ;

Exécuter 1'analyse et apporter des corrections au modéle s'il y a lieu ;

Exploiter les résultats d'analyse (visualisation graphique, listes, exportation des résultats
... ete.)

L'organigramme illustré sur la figure 1.3 présente les différentes opérations et controles a
effectuer dans ETABS pour mener correctement le calcul d'une structure suivant le Réglement
Parasismique Algériens 99 Version 2003.
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Figure 1.3. Organigramme récapitulatif des étapes de modélisation.
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CHAPITRE .II. MODELISATION DE LA STRUCTURE

CHAPITRE .IL.
MODELISATION DE' |\
LA STRUCTURE

Définition de systémes de coordonnées et de la géométrie de la structurd

Définition et affectation des parameétres du modéle

Exercice

1. Définition de systémes de coordonnées et de la géométrie
de la structure

La définition d'un modéle de structure en ETABS se fait par l'utilisation de deux types de
systémes de coordonnées. Le systéme global de coordonnées est un systéme arbitraire dans
I'espace, il est utilisé pour définir les coordonnées des nceuds et pour donner la direction des
charges. Le systéme local de coordonnées est associé & chaque élément et est utilisé pour la
spécification de charges locales, pour l'interprétation des efforts et par conséquent les résultats.

Dans la plupart des cas, le modéle de structure est défini par l'interméde d'un réseau plan de
référence, dont les axes s'utilisent comme repére pour le positionnement des membrures. Pour la
définition verticale de la structure, on utilise les données concernant les niveaux.

Pour la création d'un réseau plan, il faut tout d'abord Démarrer le programme ETABS et
Commencer un nouveau modeéle en cliquant ( File >New model... ) et Choisir les paramétres
par défaut ( Default.edb ). La figure II.1 décrit les étapes précédentes.

M ETABS Nonlinear v9.7.0 - (Untitied) N - o ™ B - T "
File ) ; C s Help ‘
Hrcivor.  con CEREEEIEEE e e T s
Egpam cul+0 | Yo 5 e ik | . e =

Import

Do you want ta inlalize yout niew model with defnitions and
preferences from an visling .edb fie? (Press F1 Kep for help.)

Display Input/Output Text Files..

Delete Analysis Files

1 Ed\..\batiment r+5 modale spectrale. EDE
2E\. AvoamlEDB

3EA\.\stade EDE

4 FA\APART2-4.EDB

Cliquer ici pour
créer un nouveau
fichier de calcul

¥
Ready [Kipin =]

Figure I1.1. Création d'un nouveau modéle de structure.
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CHAPITRE .II. MODELISATION DE LA STRUCTURE

Les étapes précédentes conduisent a la création automatique d'un modéle "de longueur de
travées réguliéres", c.a-d. méme si les travées de notre batiment ne sont pas réguliéres, les
modifications seront effectuées plus tard. La figure I1.2 présente les données de notre modéle.

~ Grid Dimengiong [Flan] ~ Story Dimensions
% Uriform Gnd Spacing f+ Simple Stary Data
4 : INumber Lines in = Direction iE Mumber of Stories

INumber Lines in v Direction Tupical Stom Height

Spacing in = Direction i?,31'52 Bttonn Stary Height
Spacing in'r’ Direction !?.31 52 ¢ Custorn Story Dats

£ Custam Grid Spacing

- Units ]
Giid Labels., | EditGid, | [Torem =] : 1

— Add Structural Objects

| o | = e 22 |
HHE el
TR = il === |
JI—H— T | H—H— 5 o I e (R 2]
Steel Deck Staggered Flat Slab Flat Slab with Wialfle Slab Two'Way or Grid Only

Truzs. Perineter Beamsz Ribbed Slab

6 Caricel l

Figure I1.2. Définition du réseau plan de référence, des données concernant les niveaux et du
type de structure en ETABS.

La figure I1.2 résume les étapes qui ménent a la création de la grille horizontale :

1. Choisir le systéme d'unités pour la saisie des données dans ETABS, dans notre cas 'unité
utilisée est " tonne - métre " ;

2. Saisir la hauteur du premier étage ;

3. Saisir le nombre des étages, pour faciliter la conception de notre modéle de structure on
va insérer que le premier étage puis nous insérons les autres étages de la structure, en
gardant les mémes caractéristiques géométriques et méme chargements du premier étage ;

4. Insérer le nombre de ligne de référence dans la direction x-x (Voir figure 1.1, 8 lignes de

A --> H);
5. Insérer le nombre de ligne de référence dans la direction y-y (Voir figure 1.1, 5 lignes de
1-->5);

6. Cliquer sur OK.

Lorsque les axes du réseau plan de référence ont des distances variables sur chaque direction, on
utilise l'option suivante ( Edit >Edit Grid Data >Edit Grid ) ou on clique sur le bouton
droit de la souris dans l'espace de dessin puis on clique sur ( Bouton droit de la sourie
>Edit Grid Data >Modifiy/Show System ... ) pour modifier les distances entre les axes
du réseau plan de référence (Voir Figure 11.3).
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Edit Grid Data... == 1

Edit Story Data...

Edit Reference Planes... e : ik

Edit R&erence Lines... = : St 1 I
Create Reference Lines on Plan Add Copy of System... |

Bk Fane Skl Spacing. Modify/Show System... ||—-— 2
Plan Mudge Value...

Lock OnScreen Grid Systern Edit

View Selected Objects Only I Corwert to Gereral Spstem

Invert Object Visibility ok | Cancel |

Remove Selected Shjects From View

Restore Visibility. Of Prévious Selected Objects

View All Objects

Delete Selected Objects

Figure I1.3. Modification de la grille de base.

Les étapes de la figure II.3 se termine par l'affichage d'une fenétre qui permet la saisie des
valeurs respectives des positions des axes du réseau plan de référence (c.a-d. les longueurs des
travées, Voir Figure I1.4).

Edit  Format |
| X GrdDats - /3 .
Gnd |0 Spacing / Line Type | Wizibility | Bubble Loz, | Grd Color - &
1 B, 3.3 Primary Show Top
& B 1 Primary Show Top
3 C 4,55 Primary Shaw Top, B
4 5] 31 Prirnary Show Top _
5 E 4,65 Prrirnary Show Top i
5 F 1 Primnary Show Top i
Fi G 3.3 Prirnary Show Top i
g H 1] Primnary Show Top i
3
10 - = Unit —
L - ray ] ¥ - 1
—% Giid Data - S4 [Tonm <] '
Grd ID Spacing # Line Type | Wigibility | Bubble Loc. | Grid Colar -  Dizplay Gridz az-
1 1.25 Primary Shiaw Left  Tidinatest &
2 42 Primary Show Left )3
3 a5 Primary Shaw Let B . o
4 0.5 Primary Show Lt B V=l i sl far s
5 0 Prirnary Shiow et B [~ GluetoGridlines 2

Bubble Size i'l 524

Reset to Default Color |

|

(Anpon St RRup BRSO R SRR R

=
L

L¥]

QK. ] Cancel |

Figure I1.4. Insertion des données de l'ouvrage modélisé.

La figure II.4 rassemble essentiellement les instructions concernant la modification de la
géomeétrie structurelle de 'ouvrage modélisé.

1.
2.

G L

Choisir le systéme d'unités, dans notre cas 1'unité utilisée est " tonne - métre " ;

Choisir l'option " Spacing ", qui permet la saisie des distances entre les lignes de
références ;

Saisir les distances entre les lignes de références dans la direction x-x ;

Saisir les distances entre les lignes de références dans la direction y-y ;

Cliquer sur OK.
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Deux vue de modeéle sont affichées (2D et 3D). Si vous maximisez une fenétre et que le modéle
n'est plus centré , il faut cliquer sur ( View >Restore Full View ). Par la suite, il faut
sauvegarder le modéle par les commandes suivantes ( File >Save ) tout en spécifiant le dossier
de sauvegarde et le nom du fichier.

2. Définition et affectation des paramétres du modéle

2.1. Définition des matériaux

Cette instruction nous permet d'introduire les propriétés mécaniques et élastiques du matériau
de la structure. Le logiciel ayants des caractéristiques par défaut de trois matériaux, le béton "
CONC ", 'acier " STEE L " et autre matériau " OTHER " qui peuvent étre changées selon
les caractéristiques demandées. Les propriétés des matériaux prédéfinis peuvent étre visualisées
et modifiées par 1'utilisateur, tout en suivant les étapes illustrées sur la figure I1.5.

1
d\o\r Select  Assign  Analyze M aterials- < Click bo: -
I . Add Mew Material... l
- OTHER

= STEEL Modify/Show Material.. === 3
2 Wall/Slab/Deck Sections... 2 i .
E Link Properties... Dl tial

Frame Monlinear Hinge Properties...

0K
Diaphragms...

Section Cuts...

H Respense Spectrum Functions...
@_‘d Time Histery Functions...

)  Dizplay Color
DE" Static Load Cases... i

Material Hame 4 ]BETDN25 ‘ Colar 1

=

cEsl, Tupe of Material —#5 | Twpe of Design
Static Nenlinear/Pushover Cases... Dithotrapis 6 ‘ Diesian IEoncrete ‘.1

Add Sequential Construction Case

B | gad Combinatiohs... i TA;L‘HSiS Pfﬂﬁér.ty Data  Design Property Data [4C1 318-05/1BC 2003)
Add Default Design Combos... Mass per unit Yolume 10 Specified Conc Comp Strength, f'c W__
Ce Mon Weight per urit Volume s Bending Reirf. YVield Stress,fy 90000
Special Seisrnic Load Effects... Modulus of Elasticity 5321 E420 Shear Reinf. Yield Stress, s [0
ay M_ass SOUrce... . Frissons Batia 10.2 ] Lightweight Concrete 7 /
e Coeff of Thermal Expansion !mﬁ Shear Strergth Reduc. Factor r‘_
Shear Moduluz W

Cancel i

Figure 11.5. Spécification des propriétés des matériauz.

Pour définir un nouveau matériau, on doit suivre les instructions énumérées ci-dessous :

n

1. Cliquer sur " Define " ;

2. Cliquer sur " Material Properties ... " ;

3. Sélectionner le matériau béton " CONC " puis cliquer sur le le bouton " Modify/Show
Material ", les propriétés des matériaux apparaissent, dans ce cas, comme valeurs
implicites ;

4. Spécifier le nom du matériau " Material Name " ;

Spécifier le type de matériau, isotrope ou orthotrope " Type of Material " ;

6. Spécifier les caractéristiques mécaniques pour le calcul des sollicitations :

ot

La masse volumique ( Mass per Unit Volum e) ;

Le poids volumique ( Weight per Unit Volume ) ;

Le module d'élasticité ( Modulus of Elasticity ) ;

Coefficient de Poisson (Poisson's Ratio) ;

Coefficient de dilatation thermique ( Coeff of Thermal Expansion ).

7. Spécifier les propriétés mécaniques attribuées pour le calcul de béton armé :

* Résistance caractéristique du béton ( Specified Conc Comp, f'c ) ;
¢ Contrainte élastique des aciers ( Bending Reinf. Yield Stress, fy ) ;
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* Contrainte de cisaillement des aciers ( Shear Reinf. Yield Stress, fys ).

8. Cliquer sur OK et reprendre cette opération pour définir d'autres matériaux.

Remarque

¢ Un matériau est dit isotrope si ses propriétés mécaniques sous charges sont identiques
dans toutes les directions. Dans le cas contraire, le matériau est dit anisotrope ou
orthotrope. En général, le béton et l'acier sont définis dans les logiciels comme matériaux
isotropes. Pour le bois, certains types de pierre avec structure stratifiée ... etc., ils sont
considérés comme des matériaux orthotropes ;

® Le coefficient de Poisson est égal a 0,2 pour le béton et de 0,3 pour l'acier.

2.2. Définition des propriétés de la section de 1'élément barre

L'élément barre est utilisé dans la modélisation des structures a ossatures, des poutres treillis,
des réseaux de poutres ... etc.

Avant d'effectuer le positionnement des éléments barres dans la structure, on doit définir les
types de sections des éléments. Chaque type de section barre est défini par les propriétés du
matériau et par les caractéristiques géométriques. Les propriétés de la section, constituées par
I'ensemble des propriétés du matériau et des propriétés géométriques, sont définies par rapport
au systéme de coordonnées local de 1'élément.

L'ETABS présente aussi des possibilités de définition des caractéristiques géométriques a partir
des bases de données (bibliothéque des profilés métalliques) des profilés en acier standard ou des
profilés a inerties variables. Les figures I1.6 et II.7 montrent la procédure de définition des
éléments barres.

[Qeﬁne Draw Select  Assign  Analyze

I’J—E\. Material Properties... - Froperties———————  Clickte;——————— [

¥ i ind:
: M ]Import | Awfide Flange _:l
2 Wall/Slab/Deck Sections...

. |
BE Link Properties... I:> [ 1Awide Flange | :||_.2

Frame Monlinear Hinge Properties... igg ::mh\;:?:ell:lange ,1

: Add Tee =

Diaphragms... add éngle 1
Add Double Angle

Section Cuts...

E Response Spectrumn Functions...
@Eﬂ Time History Funchions...

DE" Static Load Cases...

b B se Spectrum Cases,.,
B i !

Static Monlinear/Pushover Cases... A 4

. : Section Hame !PF‘SE[><45

Add Seguential Construction Case |
EE“' | oad Com b, B -Properties ——————— ~ Property Modifiers — :--;Latirie| —BK-—

£idd Diefaukt Desigr Combios.. Section Properties... I [ Set Modifiers. . I | :]l

Cora iedFCases:  Dimensions |

Special Seismic Load Effects... Depth [t3] 6 243 &

27 Mass Source.. width [t2 ] 7 03 Bl | T
— Concrete — = LLEL T
R inf il
8 _| einforcenen iI Display Color l_
II_H—DK_H —_!Cancel

Figure 11.6. Définition des sections des éléments de barre "partie 1".

"R RN



CHAPITRE .II. MODELISATION DE LA STRUCTURE

— [
~ Design Type i rf Froperties — Click to:
| (@ ' ; 45
, | Calumn Beam Type it property to find: Import 1/wide Flange -
| Concrete Cover to Rebar Center 1 jF'F_'SEMelS
10,045 PEH3M-A0 £dd Rectangular -
Tep POT3045 | 2 i
Aot 0,045 E:>' | |Lipraas
i~ Reinfarcement Dwverrides for Ductile Bearis -
Left Fight Delete Property 1
Tap o o 12 IS |
Bott 0 1]
| (8o fo | | | . 13— o |
10 Cancel ! Cancel ]

Figure 11.7. Définition des sections des éléments de barre "partie 2".

Les figure I1.6 et II.7 montrent les étapes de définition des propriétés de 1'élément barre, ces
étapes peuvent étre résumeées comme suit :

1.
2.

© 00N> U

10.

12.

13.

Cliquer sur le menu principal " Define >Frame Sections " ;

Cliquer sur la fleche pour choisir le type de la section (rectangulaire, circulaire, Section
en T ... etc.) ;

Dans notre cas nous avons des sections rectangulaires, on choisit " Add Rectangular
n .

Spécifier le nom de la section ;

Choisir la nature du matériau de la section (béton ou acier) ;

Spécifier la hauteur de la section " Depth " ;

Spécifier la largeur de la section " Width " ;

Cliquer sur le bouton " Reinforcement " pour choisir le type de la section ;

Cocher le type approprié de la section, s'il s'agit d'un poteau il faut cocher " Column
" ou cocher " Beam " pour le cas des poutres ;

Cliquer sur OK pour confirmer le type de la section ;

Cliquer sur OK et reprendre les étapes 3 -->10, pour définir les autres sections ;

Aprés la définition de toutes les sections, une fenétre apparait et affiche toutes les
sections définies ;

Cliquer sur OK pour confirmer la définition des sections.

2.3. Définition des propriétés de 1'élément plaque

L'élément plaque est utilisé pour la modélisation des coques (réservoirs, coupoles) ou des plaques
(dalles, voiles etc.). Ce type d'élément n'équilibre que les moments d'axes tangents a leur
surface et des forces perpendiculaires au plan tangent. Trois degrés de liberté sont pris en
compte au niveau de chaque nceud, deux rotations dans le plan tangent, une translation
perpendiculaire au plan auxquels sont associés deux moments et une force. Le comportement de
plaque plane fléchie n'inclut pas l'effet des déformations de cisaillement.

Chaque type de section de est défini par les propriétés du matériau et par les caractéristiques
géométriques. Les caractéristiques de la section (l'ensemble des propriétés du matériau et des
caractéristiques géométriques) sont définies par rapport au systéme de coordonnées local de
I'élément. Pour définir un type de section plaque, on doit suivre les étapes illustrées sur les
figures I1.8 et I1.9.
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Figure I1.8. Définition des sections des éléments de plaque "Partie 17.
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Figure 11.9. Définition des sections des éléments de plaque "Partie 2.

Les figures I1.8 et I1.9 montrent la procédure de définition des caractéristiques des différentes

sections de 1'élément plaque :
n

1. Cliquer sur le menu principal " Define > Wall/Slab/Deck Frame Sections ... " ;
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2. Cliquer sur la fléche pour spécifier le type de 1'élément plaque. Trois types d'élément
plaque apparaissent dans la boite de dialogue (Cas A : Add New Deck , Cas B : Add
New Slab , Cas C: Add New Wall ) ;

Cas A : Add New Deck, cette commande est utilisée pour définir les planchers portant dans
un seul sens (Exemple : le cas des planchers nervurés)

* A.1: Donner le nom de 1'élément plaque (le logiciel propose des noms par défaut) ;

* A2 : Dans le cas ou les dimensions des corps creux ne sont pas connues, on coche
l'option " Solid Sla b " dans le cas contraire on coche 'option " Filled Deck "

A.3 : Introduire la valeur de 1'épaisseur du plancher ;

A 4 : Indiquer le type de matériau du plancher ;

A.5 : Spécifier la contrainte élastique des aciers ;

A.6 : Cliquer sur OK pour confirmer la création du plancher.

Cas B : Add New Slab, cette commande est utilisée pour définir les planchers portant dans
deux sens ou plus (Exemple : le cas des dalles pleines)

B.1 : Donner le nom de 1'élément plaque (le logiciel propose des noms par défaut) ;
B.2 : Indiquer le type de matériau de la dalle ;

B.3 : Introduire la valeur de 1'épaisseur du plancher ;

B.4 : Cliquer sur OK pour confirmer la création de la dalle.

Cas C : Add New Wall, cette commande est utilisée pour définir les voiles

C.1 : Donner le nom de 1'élément plaque (le logiciel propose des noms par défaut) ;
C.2 : Indiquer le type de matériau du voile ;

C.3 : Introduire la valeur de 1'épaisseur du voile ;

C.4 : Cliquer sur OK pour confirmer la création du voile.

2.4. Conception du modéle de la structure

2.4.1. Affectation des sections de l'élément barre aux éléments de la structure

Aprés la définition des types des sections de 1'élément barre, il est indispensable de spécifier le
type de section pour chaque élément de la structure. Par exemple, les poteaux sont de type
POT30X45, les poutres principales sont de type PP30X45 et les poutres de chainages sont de
type PCH30X40. La figure I1.10 montre les différentes commandes permettant 1'affectation des
propriétés de sections aux éléments appropriés.

Eile Edit View Define | Draw  Select Assign  Analyze Display Design  Options  Help
J| = i Eﬁ K7 \'Eﬁklect Object

e
|| o Amk iR
! e s

:g_‘: ‘.! JL: ;g; §_'_K Reshape Object 1 2
| :U: Draw Point Objects /

Draw Line Ohbjects i Draw Lines (Plan, Elev, 3D) I

Draw Area Objects Create Lines in Begion or at Clicks (Plan, Elev, Eln)

u:} Diaw Developed Elevation Definition.. Create Columns in Region or at Clicks (Plan] I— 3
Beaw!Sactinn Gibk 5%, Create Secondary Bearns in Region or at Clicks (Plan)

2 Draw Digmension Line R

 Draw Reference Point

Snap to 2

Figure I11.10. Commandes permettant l'affectation des éléments de barre.

Pour affecter la section des poteaux et/ou des poutres, on suit les étapes suivantes :

1. Cliquer sur le menu principal Draw >Draw Line Objects ;

2. Pour l'affectation des poutres, on clique sur la commande Draw lines (Plan, Elev,
3D) ;

3. Pour 'affectation des poteaux, on choisit la commande Create Columns in Region
or at Clicks (Plan) .

L'affectation des poteaux et des poutres peut étre effectuée par les icones figurées dans 1'espace
de travail (Voir figure I1.10).
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a) Affectation des poteaux

Pour le positionnement des poteaux, on clique tout d'abord sur le menu principal Draw
>Draw Line Objects >Create Columns in Region or at Clicks (Plan) , puis on suit
les étapes suivantes (Voir figure I1.11) :

1. Cliquer sur " Property " pour choisir le type de la section, dans notre cas, on choisit
POT30X45 ;

2. Spécifier 1'angle de rotation de la section, cette opération permettra la modification de
l'orientation des axes locaux de 1'élément barre, c.-a-d. 1'orientation de la direction de la
plus grande dimension de la section du poteau ;

3. Cliquer sur l'emplacement des poteaux en fonction de leurs positions par rapport aux
lignes de références.

Pour interrompre 1'action de cette commande, il suffit de cliquer sur le bouton droit de la souris.

&l Plan View - STORYL - Elevation 408 Line Draw Mode = =[]

[ Property POT 30445
|| Moment Releazes Continuous
|| Angle

|| Plan Dffset
|| Plan Offzet

Figure 11.11. Affectation des poteauz.

b) Affectation des poutres

La création des poutres s'effectue en fonction des positions des appuis. Pour l'attribution des
poutres, on clique tout d'abord sur le menu principal Draw >Draw Line Objects >Draw
lines (Plan, Elev, 3D) , puis on suit les étapes suivantes (Voir figure 11.12) :

1. Cliquer sur Property pour choisir le type de la section, dans notre cas, on choisit
POT30X45 ;

2. Un premier clic sur le point de départ de la poutre suivi par un deuxiéme sur l'autre
extrémité de la poutre.

Pour interrompre 1'action de cette commande, il suffit de cliquer sur le bouton droit de la souris.
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I

& Plan View - STORYL - Elevation 4,08 Line Braw Mode = ol

- Type of Line Frame
Property FF 345
Moment Releazes Continuous

Plan Offzet Mormal 0,
Drawing Contral Tupe Monhe <zpace barx

Figure 11.12. Affectation des poutres.

L'affectation de sections des poteaux et des poutres conduira & l'obtention d'un réseau de
portiques du rez-de-chaussée (Voir figure I1.13).

iﬁ. Plan Wiew - STORYL - Elevation 4,08

Figure I1.13. Vue en plan et en 3D des portiques de rez-de-chaussée.

2.4.2. Affectation des sections de 1'élément plaque au éléments de la structure

Aprés la définition des différents types de sections des éléments plaques, cette instruction
consiste & spécifier le type de section pour chaque élément plaque de la structure. Par exemple,
les planchers nervurés, les balcons ... etc. Dans la plupart des cas, 1'élément plaque peut avoir 3,
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4 ou plus de 4 nceuds. L'élément quadratique (4 nceuds) offre une meilleure précision des
résultats, par rapport aux autres éléments. La figure II1.14 illustre les différentes commandes
permettant 1'affectation des propriétés de sections des éléments plaques.

4l ETABS Nonlinear v8.7.0 - Document de caleul

File Edit View Define . Draw Select Assign  Apalyze Display Design  Options  Help
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D:} Draw Developed Elevation Definition... |8 braw Rectangular Areas (Plan, Elev) 2.2

Sy e R Create Areas at Click (Plan, Elev) 2.3
= [raw Walls (Plan)

==t (Create Walls in Region or at Click (Plan)
B Draw Windows

#2 Draw Dimension Line

= Draw Reference Point

Sng.!a to '] T Draw Doors
2.1
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Figure 11.14. Commandes permettant l'affectation des éléments de plaque.

Pour affecter la section des éléments plaques, on clique sur le menu principal Draw >Draw
Area Objects , une boite de dialogue s'affiche et montre trois commandes (la commande
2.1, la commande 2.2 et la commande 2.3) qui permettent l'attribution des éléments
plaques. Dans ce qui suit nous présenterons le role de chacune de ces commandes.

* Commande 2.1 : Draw Area (Plan, Elev, 3D)

Cette commande est utilisée pour créer n'importe quelle forme de panneaux (3, 4 et plus de 4
neeuds). La figure I1.15 montre 1'utilité de cette commande dans la création des planchers.

1. Cliquer sur licone Draw Area (Plan, Elev, 8D) ou par l'intermédiaire du menu
principal ( Draw >Draw Area Objects >Draw Area (Plan, Elev, 3D) ;

2. Cliquer sur Property pour choisir le type de 1’élément plaque (Dans notre cas, on choisit
PLANCHERETAGE pour les planchers nervurés et BALCON pour les dalles pleines) ;

3. Cliquer sur Local Axis pour modifier 1'orientation des axes locaux de 1'élément plaque,
c.-a~-d. l'angle avec lequel le sens des nervures sera pivoté. Cette commande est
généralement utilisée dans le cas des planchers nervurés ;

4. Cliquer par le bouton gauche de la souris sur les sommets du contour du plancher puis le
bouton droit pour interrompre 1'action de cette commande et pour confirmer la création
du plancher.

I Froperty PLANCHEHETAGE;
Local Asis a0 —

Drawing Control Mone <space barr

= ofa)

Figure I1.15. Premiére méthode d'affectation des planchers.
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* Commande 2.2 : Draw Rectangular Areas (Plan, Elev)

Cette commande ne permet de créer que des panneaux de formes rectangulaires et/ou carrées.
La figure I1.16 illustre les différentes étapes de cette commande dans la création des planchers
rectangulaires et/ou carrés.

1. Cliquer sur licone Draw Rectangular Areas (Plan, Elev) ou par l'intermédiaire du
menu principal ( Draw >Draw Area Objects >Draw Rectangular Areas (Plan,
Elev) ;

2. Cliquer sur Property pour choisir le type de I’élément plaque (Dans notre cas, on choisit
PLANCHERETAGE pour les planchers nervurés et BALCON pour les dalles pleines) ;

3. Cliquer sur Local Awxis pour modifier l'orientation des axes locaux dans le cas des
planchers nervurés c.-a-d. 'angle avec lequel le sens des nervures sera pivoté ;

4. Cliquer et maintenir le bouton gauche de la souris enfoncé sur le premier coin du
plancher <O> et faire glisser en diagonale le curseur de la souris jusqu'au coin opposé <
O'> du plancher.

Froperty FLANCHERETAGE
Local Asis an

# Dirmenszion [if no drag) 0.
% Dimenzion [if no drag] 0

Figure I1.16. Deuxiéme méthode d'affectation des planchers.
¢ Commande 2.3 : Create Areas at Click (Plan, Elev)

Cette commande est utilisée pour créer des panneaux de n'importe quelle forme tout en cliquant
a l'intérieur du contour du panneau. Cependant, il est recommandé d'utiliser cette commande
que pour le cas des contours fermés c.-a-d., les lignes de références ne doivent pas passer par le
contour du plancher. La figure I1.17 résume les étapes précédentes.

1. Cliquer sur l'icone Draw Rectangular Areas (Plan, Elev) ou par l'intermédiaire du
menu principal ( Draw >Draw Area Objects > Create Areas at Click (Plan,
Elev) ;

2. Cliquer sur Property pour choisir le type de 1’élément plaque (Dans notre cas, on choisit
PLANCHERETAGE pour les planchers nervurés et BALCON pour les dalles pleines) ;

3. Cliquer a l'intérieur du contour fermé du plancher. La figure I1.17 montre deux cas de
contour de plancher, un contour fermé et un autre séparé par une ligne de référence.

D'aprés la figure I1.17, on constate que l'utilisation de cette commande, dans le cas des contours
séparés par des lignes de référence, conduit a 1'obtention des planchers incomplets.
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| Property [
Local Axiz

Plancher incomplet |

F_E‘_ 4|

2éme Clique

ler Clique

Figure I1.17. Troisieme méthode d'affectation des planchers.

L’affectation des éléments plaques de la structure conduira & la création du plancher de
rez-de-chaussée (voir figure I1.18).

D_;W. Plan View - STORYL - Elevation 4,08 Area Draw Mode

Figure I1.18. Vue en plan du plancher de rez-de-chaussée.

2.4.3. Insertion des étages
Cette instruction permet d'insérer un ou plusieurs étages dans une structure, en gardant les

mémes caractéristiques géométriques d'un étage similaire choisi dans le menu de la commande.
La figure I1.19 décrit les différentes étapes qui permettent l'insertion de nouveaux étages.
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Figure 11.19. Insertion des étages.

Notre structure est composée de 5 étages, pour les insérer on doit suivre les étapes suivantes :

1. Cliquer sur le menu principal Edit >FEdit Story Data

2. Cliquer sur Insert Story , une boite de dialogue s'affiche ;

3. Saisir la hauteur des étages & insérer, dans notre cas nous avons 5 étages de 3.06m de
hauteur ;

4. Préciser le nombre des étages & insérer ;

5. Cliquer sur OK pour confirmer l'insertion des étages.

La figure I1.19 montre la vue en plan de notre structure ce qui confirme 1'insertion des 5 niveaux
de la structure (Hauteur totale du batiment 19.38m).

2.4.4. Conditions aux limites (Appuis)
Les appuis peuvent étre spécifiés comme articulés, encastrés, ou comme encastrés avec certaines
relaxations. ETABS permet aussi de définir des appuis élastiques. Dans le cas présent, il s'agit

d'encastrements a la base des poteaux. La figure I1.20 décrit les principales étapes qui
permettent la sélection des bases de poteaux afin d'assigner les appuis.
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Figure I11.20. Méthode de sélection des bases de poteauz.

La sélection des bases de poteaux s'effectue comme suit :

* Premiére méthode

1. Cliquer sur le menu principal " Select >By Story Level " ;

2. Une boite de dialogue s'affiche et permet de choisir le niveau & sélectionner, dans
notre cas on choisit " BASE " pour sélectionner les bases de poteaux ;

3. Cliquer sur OK pour confirmer la sélection des bases de poteaux.

* Deuxiéme méthode
La sélection des bases de poteaux peut étre effectuée par l'intermédiaire des commandes
A, B, C et D qui permettent respectivement :

® d'afficher une vue en 3D ;

® d'afficher une vue en plan d'un niveau en fonction de sa hauteur ;

e d' afficher un portique en élévation en fonction de sa position par rapport aux
lignes de références ;

* de changer le niveau pour la sélection et/ou le chargement.

1. Cliquer sur la commande B ;

2. Une boite de dialogue s'affiche et permet de choisir le niveau a sélectionner, dans
notre cas on choisit " BASE " ;

3. Cliquer sur OK pour confirmer l'affichage du niveau " BASE " c.a-d. le niveau
de bases de poteaux ;

4. Sélectionner la base de tous les poteaux a l'aide de la souris.

Une fois, les bases de poteaux sont sélectionnées, on procéde a 'attribution des appuis aux bases
de poteaux (Voir figure I1.21)
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Figure 11.21. Affectation des appuis aux bases de poteau.

La figure 11.21 montre les étapes d'affectation des appuis a la base des poteaux :

Cliquer sur le menu principal Assign >Joint/Point ;

Cliquer sur " Restraints (Supports)... " ;

1
2.
3. Choisir le type d'appuis (Encastrement, appuis double, appuis simple ou point libre)
4. Cliquer sur OK pour attribuer le type d'appuis choisi aux bases de poteaux.

2.4.5. Diaphragmes

Le diaphragme est un élément plaque plan, rigide dans son plan, horizontal ou incliné, assurant

trois fonctions principales.

¢ Transmettre les charges sismiques horizontales sur les éléments verticaux de
contreventement (murs, travées triangulées ou portiques). La transmission des charges
s'effectue par effet de poutre, car le diaphragme se comporte comme une poutre située

dans le plan des charges horizontales ;

* Raidir les batiments a la maniére d'un couvercle de boite. Le raidissage vise a prévenir le

déversement des éléments porteurs verticaux

* Coupler les éléments verticaux. Tous les éléments solidaires du diaphragme travaillent en
phase et participent a la résistance en proportion de leur rigidité.

Les diaphragmes sont nécessaires a tous les niveaux. Ils peuvent donc étre constitués par des

planchers et toitures-terrasses (planchers en béton,

béton, charpente métallique ou bois,...).

bois, acier,...) ou des toitures inclinées (en

Les différents types de planchers et toitures « plaques » ne constituent un diaphragme rigide
que dans le respect de certaines dispositions constructives qui assurent un comportement

dynamique satisfaisant, a savoir :
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Solidarisation impérative avec les chainages périphériques et poutres qui assurent la
liaison avec les palées de stabilité ;

Renforcement des bords des trémies dont les dimensions doivent étre limitées (sinon,
dispositions compensatrices pour éviter les déformations du diaphragme) ;

Si la « plaque » est constituée de plusieurs couches, liaisons entre les couches de fagon a
assurer un comportement dynamique homogéne ;

En cas de béton armé éviter les reprises de coulage du béton entre la dalle et les
chainages, poutres, chapiteaux...

/(‘ Remarque

Un diaphragme rigide impose le méme déplacement en téte de chaque élément
vertical, ce qui permet de solliciter équitablement toutes les palées de stabilité. En cas de
rupture d'une palée de stabilité, la répartition des charges se fait automatiquement sur
les autres ;

Un diaphragme flexible n'a pas un comportement dynamique continu de part et
d'autre des éléments verticaux (palées, mais également poteaux), et chaque élément
recoit une charge proportionnelle & la surface de plancher le concernant comme pour les
charges verticales.

Ezxemple

Exemples de diaphragmes plaques

Dalle pleine de béton armé coulé en place ;

Dalle pleine de béton armé coulé en place sur pré-dalles ;

Dalles préfabriquées en béton armé ;

Planchers a dalle de compression sur poutrelles en entrevous (notre cas) ;
Planchers & dalle de répartition sur toles d'acier profilées ;

Planchers et pans de toiture bois & panneaux de contreplaqué ;

Planchers et pans de toiture a lames de bois massif.

Chaque type de plaque pour chaque type de matériaux utilisés doit faire I'objet d'une mise en
ceuvre précise pour assurer effectivement sa fonction de diaphragme rigide. Les régles de
construction précisent ces mises en ceuvre.

La figure I1.22 montre la procédure d'insertion d'un diaphragme rigide.

1.

G

Sélectionner 1'ensemble de la structure a partir du menu principal Select >All Ctrl +
A ou par l'icone all ;

Cliquer sur le menu principal Assign >Joint/Point ;

Cliquer sur Diaphragms ;

Une boite de dialogue qui s'affiche et permet de sélectionner le diaphragme rigide "D1" ;
Cliquer sur OK pour attribuer le diaphragme a tous le niveau. L'affectation du
diaphragme a tous les niveau s’accompagne par 'apparition d'un point sur la vue en plan
de chaque niveau de la structure. Ce point représente le centre de masse de chaque

niveau de la structure.
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Figure I1.22. Insertion du diaphragme.

3. Exercice

La vue en plan d'un batiment en R+4 & usage de bureaux est illustrée sur la figure 11.23.
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Figure I11.23. Vue en plan de la structure.

Sachant que :

* La section des poteaux est de 30x40 ;

* La section des poutres porteuses est de 30x40 ;

* La section des poutres de chainage est de 30x35 ;

* Les matériaux utilisés sont le béton le B30 et l'acier de nuance FeE 500 ;
* Les planchers sont en corps creux d'épaisseur 20cm ;

® Les balcons sont des dalles pleines d'épaisseur égale & 15cm ;

¢ La hauteur des étages est égale a 3.06m.

A travers les différentes commandes d'ETABS, on demande de :
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Définir les différentes propriétés des matériaux utilisés dans ce projet.

Modéliser les différents composants de la structure en fonction des données citées ci-dessus.
Insérer les étages de la structure.

Attribuer les conditions aux limites (Diaphragme et appuis) aux éléments appropriés.
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CHAPITRE .111.

ATTRIBUTION DES
CHARGES

STATIQUES AUX

ELEMENTS DE DE

LA STRUCTURE

Définition des cas de charges statiques (Permanent et d'Exploitation)

Attribution des charges linéaires

Attribution des charges surfaciques aux éléments plaques

Combinaisons de charges

Exercice

L]l
IEiIIEiIIEiIIEiIIEiIl

1. Définition des cas de charges statiques (Permanent et

d'Exploitation)

Cette option permet de définir plusieurs cas de charges et leurs types. ETABS permet de
définir : les charges permanentes ( DEAD ), d'exploitations ( LIVE ), sismiques ( QUAKE ),
du vent ( WIND ), de la neige ( SNOW ) et d'autres. La figure III.1 montre les différentes
étapes qui permettent la définition des cas de charges statiques.

Define Draw  Select  Assign  Apalyze
[FE, Material Properties...

’E‘i Frame Sections...

2: Wall/Slab/Peck Sections...

x Link Properties...

Frame Monlinear Hinge Properties...

Diaphragms...

Section Cuts...

E Response Spectrum Functions...
B Time History Functions...

Static Monlinear/Pushover Cases...
Add Seguential Construction Case

B L oad Combinations...
Add Default Design Combos...

Figure III.1. Définition de cas de charges statiques.

Les étapes illustrées sur la figure I11.1 peuvent étre détaillées comme suit :

mEEE
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Load Type fultiplier Lateral Load
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2 K | 4

|
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STRUCTURE

1. Cliquer sur le menu principal " Define >Static Load Cases " ;

2. Donner le nom du cas de charge. Dans notre cas, on saisit G pour les charges
permanentes et Q pour les surcharges d'exploitation ;

3. Sélectionner le type du cas de chargement statique désiré, c.-a-d. la nature de la charge «
poids propre ; permanentes ; vent ; neige et sismiques » ;

4. Saisir le coefficient de multiplication. Ce coefficient est utilisé que dans le cas des charges
permanentes. Si ce coefficient est pris égal & 1, le poids propre de la structure sera estimé
automatiquement par le logiciel, dans le cas contraire (le coefficient est égal a 0), le poids
propre de la structure doit étre calculé et introduit par 'opérateur. Pour les autres cas de
charges, ce coefficient est pris égal a 0 ;

5. Cliquer sur la commande Add New Load pour ajouter d'autres cas de charges ;

6. Une fois la définition de cas de charges est terminée, on clique sur OK pour confirmer la

création des cas de charges définis.

2. Attribution des charges linéaires

L'acrotére est un mur périphérique situé au sommet de la structure (terrasse) pour permettre le
relevé d'étanchéité. L'acrotére est considérée comme une charge permanente et répartie d'une
maniére uniforme sur les poutres périphériques du plancher de terrasse de la structure.
L'attribution des charges de l'acrotére s'effectue comme suit (Voir figure I11.2) :

1.

2.

G W

®© N>

10.
11.

Sélectionner " One Story ", Cela permet d'appliquer les charges de l'acrotére au niveau
du dernier étage ;

Cliquer par le bouton droit de la souris sur toutes les poutres périphériques du plancher
de terrasse pour les sélectionner ;

Cliquer sur le menu principal " Assign >Frame/Line Loads " ;
Choisir " Distributed ... " c.-a-d. charge linéaire uniformément répartie ;
Choisir le type de la charge, dans le cas de l'acrotére on choisit "G
permanente" ;

Choisir 'unité de la charge a attribuer ;

Sélectionner la nature de la charge a attribuer (Forces ou Moments) ;
Sélectionner la direction de la charge " Gravity ", cela permet de suivre le sens
gravitaire ;

Cocher l'option " Replace Existing Loads ", cette option est utilisée pour remplacer
la nouvelle charge a attribuer par les anciennes charges affectées aux éléments
sélectionnés ;

Saisir la valeur du poids propre de l'acrotére " G = 0.1 t/ml " ;

Cliquer sur OK pour confirmer l'affectation de la charge de l'acrotére aux poutres
sélectionnées (Voir figure I11.2).

charge
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[ istributed..
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“ Group Names...

Open Structure Wind Parameters...

y

Clear Display of Assigns

Copy Assigns

Pacte Assigns

1 ==

Optiory 1
’ & AddioEsstingloads O

| Load Case Name s—”ﬁ

Load Type and Direction

7

oo & Foces O Moments
Direction || Gravity -

Trapezoidal Load: IS
1

{+ Feplace Existing Loads

£ DeletaExistingLoads * 0

2 3 4
Distance 0. 028 [o.7s [
Load o o, o .

& Relative Distance from End-| " Absolute Distance from End

Uniform Load ——— i1
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Figure I11.2. Attribution des charges de l'acrotére aux poutres périphériques du plancher de

terrasse.
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3. Attribution des charges surfaciques aux éléments plaques

L'ETABS permet de spécifier les charges surfaciques sur les éléments bidimensionnels (plaques).
Ces charges surfaciques sont uniformément réparties par m? selon les axes locaux ou globaux de
la structure. Les charges d'exploitation sont définies par le DTR BC 2.2 selon l'usage de
I'ouvrage. Dans notre cas, elles sont de l'ordre de 0.15 t/m? pour l'étage courant, 0.1 t/m?
pour le plancher de terrasse et 0,35 t/m? pour les balcons. Dans ce qui suit, nous présenterons
les différentes instructions qui conduisent & l'affectation des charges surfaciques aux éléments
plaques

3.1. Attribution des charges d'exploitation aux planchers (étages
courants et étage de terrasse)

Avant d'attribuer les surcharges d'exploitation aux planchers de la structure, il faut tout
d'abord les sélectionner. La figure II1.3 montre la procédure de sélection des planchers (étages
courants et terrasse).

[ Select [ Assign  Apalyze  Display

at Peinter/in Window .
: —Select
ﬁ‘)& Intersecting Line %
=11 MR

on £Y Plane E> FLANCHERETARE
G KE e ’
on ¥Z Plane
by Groups... Cancel |
by Frame Secticns...

e Clear &l |
by WallfSlab/Beck Sections..

by Link Properties...

by Line Object Type...
by Area Object Type.

by Pier ID.. €| (\ ®
by Spandrel ID...
by Story Level...
Al 4 Chrl+ A .
Invert :

Deselect b

et Get Previ

i Clear Selection

sz Selection

Figure I11.3. Procédure de sélection des planchers.

Les instructions illustrées sur la figure II1.3. peuvent étre détaillées comme suit :

1. Cliquer sur le menu principal " Select >by Wall/Slab/Deck Sections ... " ;

2. Choisir 1’élément plaque a sélectionner (dans ce cas, on sélectionne
PLANCHERETAGE) ;

3. Cliquer sur OK pour confirmer la sélection de tous les planchers de la structure.

Une fois tous les planchers sont sélectionnés, on suivra les instructions de la figure II1.4 pour
attribuer la charge d'exploitation aux planchers :

1. Cliquer sur le menu principal " Assign >Shell/Area Loads " ;

2. Cliquer Uniform , une fenétre qui s'affiche et permet la saisie des paramétres de la
charge a attribuer ;

3. Choisir ['unité de la charge & attribuer ;

4. Choisir le type de la charge, dans ce cas, on choisit "Q : charge d'exploitation" ;
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5. Cocher l'option " Replace Existing Loads ", cette option est utilisée pour remplacer
la nouvelle charge a attribuer par les anciennes charges affectées aux éléments
sélectionnés ;

6. Saisir la valeur de la charge " Q = 0.15 t/m? " ;

7. Sélectionner la direction de la charge " Gravity
gravitaire ;

8. Cliquer sur OK , l'affectation de la charge d’exploitation aux planchers se traduit par
'apparition des valeurs de la charge sur la vue en plan des plancher (Voir figure 111.4).
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" cela permet de suivre le sens
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Frame/Line k Load Case Name ’71 Ton-m |_V_
Shell/Area » - i
- : — Unitorm Load \' B
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= ™ Add to Existing Loads X

Frame/Line Loads

Shell/Area Loads

E> Load  G=—[015 '

i Direction  § | Grawit -
ic; Temperature.., | I i __I i

Wind Pressiure Coefficient...

- i
_Clear Display of g 8 ‘Cancel I

T—

|+ Replace Existing Loads |
i Delete Existing Loads \i

“4 Group Names...

-

Paste Assigns

B ® OV
XL

Figure 111.4. Attribution des charges d'exploitation aux planchers.

3.2. Attribution des charges d'exploitation aux balcons

Avant d'attribuer les surcharges d'exploitation aux balcons, il faut tout d'abord les sélectionner.
La figure II1.5 montre la procédure de sélection des balcons.
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Figure II1.5. Procédure de sélection des balcons.

Les instructions illustrées sur la figure II1.5. peuvent étre détaillées comme suit :

1.
2.
3.

Cliquer sur le menu principal " Select >by Wall/Slab/Deck Sections ... " ;
Choisir I’élément plaque a sélectionner (dans ce cas, on sélectionne BALCON) ;
Cliquer sur OK pour confirmer la sélection de tous les balcons de la structure.

Une fois tous les balcons sont sélectionnés, on suivra la étapes suivantes (figure III.6) pour
attribuer la charge d'exploitation aux balcons :

1.
2.

Cliquer sur le menu principal " Assign >Shell/Area Loads " ;
Cliquer Uniform , une fenétre qui s'affiche et permet la saisie des paramétres de la
charge a attribuer ;

3. Choisir ['unité de la charge a attribuer ;
4.
5. Cocher l'option " Replace Existing Loads

Choisir le type de la charge, dans ce cas, on choisit "Q : charge d'exploitation" ;

" cette option est utilisée pour remplacer
la nouvelle charge a attribuer par les anciennes charges affectées aux éléments
sélectionnés ;

Saisir la valeur de la charge " Q = 0.35 t/m? " ;
Sélectionner la direction de la charge " Grawvity
gravitaire ;

Cliquer sur OK pour confirmer l'affectation de la charge d'exploitation aux balcons (Voir
figure II1.6).

" cela permet de suivre le sens
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Figure I111.6. Attribution des charges d'exploitation aux balcons.

3.3. Attribution des charges d'exploitation au plancher de terrasse

Etant donné la surcharge d'exploitation du plancher de terrasse vaut 0.1 t/m2, il est
indispensable de remplacer les charges d'exploitation précédentes du plancher de terrasse par la
valeur 0.1 t/m? (c.-a-d. 0.1t/m? au niveau des balcons et des planchers). La figure IIL.7 illustre
les étapes qui permettent de changer la charge d’exploitation au niveau du plancher de terrasse

| > : Jeint/Point
T Frame/Ling
: Shell/Area

i Temperature..,

7 1T
b2 Uniforti,

Wind Pressure Cogfficient...

Clear Display of Assigns 1

Copy Assigns

Paste Assigns 3

Load Case Name 3—"& “:JI
T
Uniforen Load Options i
Load !0‘1 " Addta Esisting Loads F

* Replane Existing Loads

Direction | Gravity ':I 1 Delete Esisting Loads
6—[\ ok || Cancel

Figure I11.7. Attribution des charges d'exploitation au plancher de terrasse.

Les instructions illustrées sur la figure II1.7 peut étre détaillées comme suit :

1. Cliquer par le bouton droit de la souris sur tous les balcons et les planchers du dernier
niveaux pour les sélectionner ;

2. Cliquer sur le menu principal " Assign >Shell/Area Loads >Uniform " ;

3. Choisir le type de la charge, dans ce cas, on choisit "Q : charge d'exploitation" ;
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4. Choisir ['unité de la charge a attribuer ;
Spécifier la valeur de la charge " Q = 0.1 t/m? " ;

6. Cocher l'option " Replace Existing Loads ", cela permet de remplacer la nouvelle
charge a attribuer par les anciennes charges affectées aux éléments sélectionnés (c.-a-d Q
= 0.1 t/m? pour les planchers et les balcons au lieu de Q = 0.15 t/m? pour les
planchers et Q = 0.35 t/m? pour les balcons) ;

7. Sélectionner la direction de la charge " Gravity ", puis cliquer sur OK pour confirmer
I'affectation de la charge d'exploitation au niveau de la terrasse.

ot

4. Combinaisons de charges

Pour déterminer les sollicitations au niveau des éléments de la structure, on utilise les
combinaisons d'actions proposées par les réglements CBA 93 et RPA 99 V2003. L'ETABS
permet d'introduire les combinaisons de charges en multipliant chaque cas de charge par son
coefficient de majoration afin d'établir le cas de chargement le plus défavorable. Pour 1'analyse
statique on distingue : I'état limite ultime (E.L.U) l'état limite de service (E.L.S). La figure II1.8
montre la procédure de définition des combinaisons de charges E.L.U. et E.L.S.
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Figure I11.8. Saisie graphique des combinaisons de charges.

Pour définir les combinaisons d'actions, on suit les étapes suivantes (figure IIL.8) :

1. Cliquer sur le menu principal " Define >Load Combinations ... " ;

2. Cliquer sur " Add New Combo... " ;

3. Spécifier le nom de la combinaison ;

4. Spécifier le cas de chargement ;

5. Saisir le coefficient de majoration ;

6. Cliquer sur " Add " puis reprendre les étapes 3, 4, 5 et 6 pour ajouter le deuxiéme cas de
charge ;

7. Cliquer sur " OK " pour confirmer la création de la combinaison ;

8. Cliquer sur " OK " aprés la définition de toutes les combinaisons de charges.

5. Exercice

Soit la structure illustrée sur la figure 11.23 (Chapitre II, § 3). On demande de :

1. Déterminer les différentes valeurs de la charge d’exploitation "Q" a travers le DTR B-C 2.2.
2. Affecter les charges d’exploitation aux différents éléments de la structure.
3. Définir les combinaisons de charges statiques permanentes selon le réglement RPA 99 V2003.
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CHAPITRE .IV.
ANALYSES
STATIQUE ET
DYNAMIQUE DE
STRUCTURES

Analyse statique linéaire
Méthode statique équivalente

Analyse dynamique de la structure

Exercice

1. Analyse statique linéaire

Un calcul statique linéaire permet de déterminer le champ de déplacements, les réactions aux
appuis, les efforts internes aux noeuds et le champ de contraintes qui existent dans une structure
soumise & divers chargements statiques (charges permanentes et surcharges d'exploitation).
Plusieurs hypothéses sont prises en considération d'une maniére implicite lors de 1'analyse
statique, & savoir:

* Comportement élastique linéaire des matériaux ;
® Petites déformations ;
* Petites rotations.

L'analyse statique linéaire est basée sur la méthode des déplacements qui consiste & satisfaire les
forces d'équilibre et les compatibilités des déplacements de chaque nceud du modéle de la
structure. Afin de réaliser l'analyse compléte de la structure, la matrice de rigidité est obtenue
par la superposition des contributions des différentes rigidités des barres et des éléments
constituant la structure. Le vecteur force est composé des charges externes réparties aux nceuds
de la structure. Le systéme d'équation a plusieurs inconnus (déplacement) ainsi obtenu est
résolu en utilisant la méthode de décomposition de Cholesky qui est bien adapté pour ce type de
problémes. Pour effectuer ce type d'analyse, il suffit d'attribuer les charges statiques (charges
permanentes et surcharges d'exploitation) aux différents éléments de la structure puis lancer le
calcul (Voir figure IV.1).
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Figure IV.1. Lancement de l'analyse statique linéaire.

La figure IV.1 résume les différentes étapes qui permettent d'effectuer 1'analyse statique
linéaire :

1. Cliquer sur le menu principal " Analyze >Run Analysis " ou par l'intermédiaire de la

touche " F'5 " du clavier ou par 'icone figurée dans 1'espace de travail ;

2. Une fois l'analyse statique est terminée, la déformée de la structure apparait en 3D puis il
faut changer I'unité pour pouvoir exploiter les résultats ;

3. Cliquer dans l'espace de travail 2D ou 3D puis sur le menu principal " Display >Show
Undeformed Shape " ou par l'icone figurée dans l'espace de travail pour montrer et
restaurer la forme non déformée de la structure.

2. Méthode statique équivalente
Introduction
Le calcul des forces sismiques peut étre mené suivant trois méthodes, & savoir :
¢ La méthode statique équivalente ;

* La méthode d'analyse modale spectrale ;
* La méthode d'analyse dynamique par accélérogrammes.

La méthode statique équivalente permet 1'analyse statique d'une structure sous l'effet d'un
systéme de forces statiques équivalentes & celui de l'action sismique. La méthode statique
équivalente si la structure répond aux conditions prescrites dans l'article 4.1.2. du réglement
RPA 99 V2003.

Pour cette méthode, les forces réelles dynamiques qui se développent dans la construction sont
remplacées par un systéme de forces statiques fictives dont les effets sont considérés équivalents
& ceux de l'action sismique. Le mouvement du sol peut se faire dans une direction quelconque
dans le plan horizontal. Les forces sismiques horizontales équivalentes seront considérées
appliquées successivement suivant deux directions orthogonales caractéristiques choisies par le
projeteur. Dans le cas général, ces deux directions sont les axes principaux du plan horizontal de
la structure.

Il faut souligner toutefois que les forces et les déformations obtenues pour 1'élément & partir des
méthodes d'analyse statiques pour les charges de conception recommandées sont inférieures aux
forces et aux déformations qui seraient observées sur la structure sous les effets d'un séisme
majeur pour lequel les charges ont été spécifiées. Ce dépassement des forces est équilibré par le
comportement ductile qui est fourni par les détails de construction de 1'élément.
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C'est pourquoi l'utilisation de cette méthode ne peut étre dissociée de 1'application rigoureuse
des dispositions constructives garantissant a la structure :

® Une ductilité suffisante ;
* La capacité de dissiper 1'énergie vibratoire transmise & la structure par des secousses
sismiques majeures.

2.1. Calcul de la force sismique totale

La force sismique totale "V", appliquée a la base de la structure, doit étre calculée
successivement dans deux directions horizontales orthogonales selon la formule (4.1) de
I'article 4.2.3 du RPA 99 V2003 (Voir figure IV.2).

4.2.3. Calcul de la force sismique totale

A.D.O
R

: coefficient d’accélération de zone
: facteur d’amplification dynamique moven

coefficient de comportement global de la structure
facteur de qualité
: poids total de la structure

- W @d.1)

SO® O »

Figure 1V.2. Calcul de la force sismique totale.

2.2. Distribution de la résultante des forces sismiques selon la hauteur

La résultante des forces sismiques & la base V doit étre distribuée sur la hauteur de la structure
selon les formules (4.10 et 4.11) de l'article 4.2.5 et 4.2.6 du RPA 99 V2003 (Voir figure
1v.3).

v=F+ LF (4-10)

(V —F,)Wh,
F o=

D Wh,

j=1

(4-11)

Figure IV.3. Distribution de la résultante des forces sismiques selon la hauteur.

La force concentrée " F;" au sommet de la structure permet de tenir compte de l'influence des
modes supérieurs de vibration. Elle doit étre déterminée par la formule suivante :
F,=007xTxV

ot T est la période fondamentale de la structure (en secondes). La valeur de Ft ne dépassera en
aucun cas 0,25 V et sera prise égale & 0 quand T est plus petite ou égale & 0,7 secondes. La

partie restante de V soit ( 'V - Ft ) doit étre distribuée sur la hauteur de la structure suivant la
formule la formule (4.11) de l'article 4.2.5 du RPA 99 V2003 (Voir figure IV.3).
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Une fois toutes les forces sismiques sont calculées, on procéde a les définir puis les appliquer sur
I'ensemble des niveaux de la structure. La figure IV.4 illustre les différentes étapes permettant la
définition et l'affectation des forces sismiques.

2.3. Définition et attribution des forces statiques fictives

Avant de lancer l'analyse par la méthode statique équivalente, les forces statiques fictives
doivent étre définies et attribuées aux différents niveaux de la structure selon les étapes des
figures IV.4 et IV.5.

|m Draw  Select  Assign
] & Material Properties...

T Frame Sections...

2 Wall/Slab/Deck Sections...

& Link Properties...

Frarme Monlinear Hinge Properties... + Load 3 .| ~Click Te:
T ‘ Selfweight  Auto
EPEagHR... Load 3 Tupe ultiplier Lateral Load
Groups.. E> e | fouske  ~ |0 JUserloads = ModiyLoad |
Section Cuts... G I 2 BE:ED 1D
R Spectrum Funct £ QUAKE 0 User Loads Modly LateraLosd._|= 6
esponse Spectrum Functions... m T
fw Time History Functions... Delete Load l
IDEL Static Load Cases... I_ —1 1
~J Rs im Cases., : Cancel I

Static Nonlinear/Pushowver Cases...

Add Sequential Construction Case

Figure IV.4. Définition des cas de forces statiques fictives.
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Figure 1V.5. Attribution de forces statiques fictives auzx étages de la structure.

Les étapes illustrées sur la figure IV.4 et IV.5 peuvent étre résumées comme suit :

1.
2.

3.

Cliquer sur le menu principal " Define >Static Load Cases " ;
Donner le nom du cas de chargement. Dans notre cas, on saisit Ex les forces agissant
dans la direction (x-x) et Ey pour le cas des forces agissant dans la direction (y-y) ;
Sélectionner le type du cas de chargement statique désiré, c.-a-d. la nature de la charge «
QUAKE » ;

Pour pouvoir distribuer les forces sismiques fictives selon la hauteur de la structures il
faut activer la commande " Awuto Lateral Load " ;

Cliquer sur la commande " Add New Load " pour ajouter le cas de charge selon les
directions (x-x) et (y-y) ;

Une fois la définition de cas de charges est terminée, on clique sur la commande "
Modify Lateral Load " pour affecter les forces sismiques aux différents niveaux de la
structure ;

Saisir les forces sismiques calculées selon la figure IV.3, pour le cas de chargement Ex
puis pour le cas de chargement Ey ;

Cocher la commande " Apply at Center of Mass ", cette derniére permets d'appliquer
les forces sismiques au niveau des planchers car ces derniers sont considérés rigides dans
leur plan ;

L'augmentation de l'effort tranchant provoqué par la torsion d'axe vertical due a
I'excentricité entre le centre de masse et le centre de rigidité doit étre prise en compte, en
cochant la commande " Additional Ecc. Ratio (all Diaph) ". Pour toutes les
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structures comportant des planchers ou diaphragmes horizontaux rigides dans leur plan,
on supposera qu'a chaque niveau et dans chaque direction, la résultante des forces
horizontales a une excentricité par rapport au centre de torsion égale a 5% de la plus
grande dimension du batiment & ce niveau (Article 4.2.7 du RPA 99 V2003) ;

10. Cliquer sur OK pour confirmer l'attribution des forces sismiques fictives au niveau des
planchers ;

11. Cliquer sur OK pour confirmer la définition et 1'attribution des forces sismiques fictives
au niveau des planchers dans les deux directions de calcul.

12. Lancer le calcul de la méthode statique équivalente selon la figure IV.1.

3. Analyse dynamique de la structure

Pendant un séisme, une construction regoit des charges verticales qui, comme les charges
horizontales doivent étre transmises jusqu'au sol d'assise de la construction. Pour ce faire, deux
approches sont possibles :

® Structures auto-stables : les descentes de charges horizontales passent par les mémes éléments
de structure que les charges verticales (murs, coques, treillis tridimensionnels, portiques
croisés...)

® Structures contreventées : les descentes de charges horizontales passent par des dispositifs
spécifiques (systémes articulés + contreventements...).

L'absence de contreventement et une concentration de contraintes trop élevée en téte de poteaux
sont parmi les principaux facteurs de ruine en cas de séisme, d’oul une étude parasismique est
indispensable afin de remédier a ce probléme. Une bonne étude dynamique (vis-a-vis des séisme)
permet d'avoir un bon comportement de la structure c.-a-d. une structure capable de reprendre et
dissiper les efforts sismiques sans qu'elle s’effondre. Dans ce qui suit nous présenterons les différentes
analyses dynamiques supportées par ETABS.

3.1. Analyse modale

Introduction

L'analyse modale permet de déterminer les modes propres de vibrations de la structure et leurs
périodes. Puisqu'il n'existe aucune force extérieure, les périodes naturelles et les modes propres
sont directement en fonction de la rigidité et de la distribution des masses de la structures (ils
sont indépendants du séisme). Par conséquent, le résultat du calcul des périodes et des modes
propres peut varier considérablement en fonction de la modélisation des masses. Avant de lancer
I'analyse modale, il est nécessaire de transformer les chargements statiques en masses pour
I'étude dynamique d'une maniére automatique & partir des charges statiques (G+Q). La figure
IV.6 illustre la procédure de transformation des charges statiques en masses.
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Figure 1V.6. Transformation des chargements statiques en masses.

Les chargements statiques ont été transformés en masses, selon 1'article 4.2.3 du R.P.A. 99
version 2003, comme suit :

1. Cliquer sur le menu principal " Define >Mass Source " ;

2. Cocher l'option " From Self and Specified Mass and Loads " ;

3. A l'aide de la liste déroulante, sélectionner les cas de chargement dans lesquels trouvent
les charges & convertir en masses ;

4. Préciser le coefficient qui permet de définir la quantité de charges a convertir en masses ;

5. Cliquer sur " Add " pour valider tous les paramétres de conversion des chargements
statiques en masses ;

6. Cliquer sur " OK " pour confirmer la transformation des chargements statiques en
masses.

Une fois tous ces facteurs sont introduits, on procéde a la définition des paramétres de 1'analyse
modale (Voir figure IV.7).
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Figure IV.7. Paramétres de l'analyse modale.

Les instructions illustrées sur la figure IV.7 peuvent étre détaillées comme suit :

1.

2.

5.
6.
7.

Cliquer sur le menu principal " Analyze >Set Analysis Options... " puis
sélectionner 1'icone " Full 3D "

Cocher " Dynamic Amnalysis " puis cliquer sur la commande " Set Dynamic
Parameters " ;

Supposer un nombre de modes (de préférable on prend un nombre supérieur au nombre
d'étages), ce nombre sera augmenté ou réduit en fonction des résultats obtenus (c.-a-d.
aprés l'exploitation des résultats) ;

Cocher l'option " FEigenvectors ", cela permet de rechercher les modes propres de la
structure ;

Cliquer sur " OK " ;

Cliquer sur " OK " ;

Lancer 'analyse a partir du menu principal " Analyze >Run Analysis ".

Aprés Iexécution de 1'analyse modale, on commence & visualiser les premiers modes propres afin
de voir le comportement de la structure. La visualisation des modes propres s'effectue comme
suit (figure IV.8) :

1.

2.
3.

Cliquer sur le menu principal " Display >Show Mode Shape " ou par l'icone figurée
dans 1'espace de travail ;
Spécifier le numéro de mode propre a visualiser ;

Cliquer sur " OK " pour visualiser la déformée du mode propre choisi.
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Figure IV.8. Visualisation des modes propres.

Les figures IV.9 et IV.10 montrent les deux premiers modes propres de la structure.
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Figure IV.9. Déformée du premier mode de vibration.
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Figure 1V.10. Déformée du deuziéme mode de vibration.

D'aprés les figures IV.9 et IV.10, on remarque ce qui suit :

* L'animation des modes propres peut étre activée tout en cliquant sur la commande 1 "
Start Animation " ;

* Le passage d'un mode a l'autre s'effectue par la commande 2 (deux fleches de
transition) ;

* Le premier mode de vibration est une translation dans la direction y-y, ce qui est
préférable ;

* Le deuxiéme mode de vibration est une torsion dans le plan x-y, ce qui est indésirable ;

® Selon l'article 4.2.4 du R.P.A. 99 V2003, la période du mode fondamentale de la structure
(premier mode, T= 1,58 s) est supérieure & celle recommandée par R.P.A. 99 V2003 (1,3
xT R.P.A. =0.60s).

Pour avoir un bon comportement des structures vis-a-vis des efforts horizontaux (séismes), il
faut respecter les conditions exigées par les réglements parasismiques, & savoir :

N

* La valeur de la période T, calculée a partir la méthode modale, ne doit pas dépasser
celles estimées a partir des formules empiriques appropriées de plus de 30% ;
® Assurer une translation dans les deux premiers modes de vibration.

Pour atteindre tous ces objectifs, il est indispensable d'utiliser un systéme de contreventement
adéquat pour rendre la structure rigide et résistante aux efforts horizontaux dans leur plan et
pour assurer la descente des charges dynamiques vers les fondations. Dans notre cas, des voiles
en béton armé seront utilisés pour assurer le contreventement de notre structure.

La disposition des voiles se fera de telle sorte a répondre aux exigences réglementaires (R.P.A.
99 version 2003) et architecturales. En assurant une translation dans les deux premiers modes
de vibration. Mais le défi majeur est des respecter les plans architecturaux pour éviter toutes
modifications au niveau des plans.

En effet, cette disposition respectera les principes de base de la conception parasismique, &
savoir :

* Eviter les rez-de-chaussée et les étages flexibles ;

* Eviter les contreventements dissymétriques ;

* Eviter les contreventements décalés ;

* Insérer les contreventements dans la périphérie de la structure pour réduire l'effet de
torsion ;

* Eviter les sauts de rigidité et de résistance.

Les figures IV.11 et IV.12 montrent la procédure d'insertion des voiles de contreventement.
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Figure IV.11. Insertion des voiles de contreventement (Partie 1).
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Al Staries

- Il faut refaire I'étape 5 pour insérer les voiles au niveau des zones choisies;

- Cliquer sur le point A puis le point B pour créer le voile.

Figure IV.12. Insertion des voiles de contreventement (Partie 2).

Les étapes illustrées sur les figures IV.11 et IV.12 peuvent étre décrites comme suit :

1.

N

Ouvrir le cadenas d'analyse, cela permettre de faire des modifications an niveau du
modéle ;

Activer le mode accrochage aux intersections, extrémités et points ;

Cliquer sur le menu principal " Draw >Draw Area Objects >Draw walls (Plan) "
ou par l'icone figurée dans l'espace de travail ;

Cliquer sur " Property "pour choisir le type de I’élément plaque (Dans notre cas, on
choisit VOILE) ;

Cliquer sur " Drawing Control " puis choisir " Drawing Control " pour fixer la
longueur des voiles & insérer ;

Spécifier la longueur du voile (Dans notre cas, la longueur des voiles est de 2 métre) ;
Activer la commande " All Stories " pour permettre l'insertion des voiles dans tous les
niveaux ;

Un premier clic sur le point de départ du voile suivi par un deuxiéme clic sur extrémité
de la poutre pour assurer la création du voile dans la direction choisie.

Aprés l'insertion de tous les voiles, on démarre 1'exécution du modéle & partir du menu principal

" Analyze >Run Analysis

" et on visualise la déformée des deux premiers modes pour les

comparer avec ceux de la structure non-contreventée. Les figures IV.13 et IV.14 illustrent les
deux premiers modes de la structure contreventée.
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P
\
Translation dans la direction x-x

Figure 1V.13. Déformée du premier mode propre aprés insertion des voiles.

Translation dans la direction y-y

Figure 1V.14. Déformée du deuxiéme mode propre aprés insertion des voiles.

D'aprés les figures 1V.13 et 1V.14, on constate que l'insertion des voiles & améliorer le
comportement de la structure, ou on a observé ce qui suit :

® Le premier mode de vibration reste une translation mais dans la direction x-x ;

* Le deuxiéme mode de vibration s'est transformé en une translation dans la direction y-y ;

* La période du mode fondamentale de la structure (premier mode, T= 0,53 s) est
inférieure a celle recommandée par R.P.A. 99 V2003 (1,3 x T R.P.A. = 0.60 s).
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CHAPITRE .IV. ANALYSES STATIQUE ET DYNAMIQUE DE STRUCTURES

e spectrale

Pour cette méthode, il est recherché pour chaque mode de vibration, le maximum des effets
(déplacements, vitesses, forces internes ... etc.) engendrés dans la structure par les forces sismiques
représentées par un spectre de réponse de calcul (c.-a-d. pour chacun de ces modes propres 1'analyse
spectrale permet de déterminer 1'accélération de chaque masse du modéle pour chacun des modes de

vibration).

Ces effets sont par la suite combinés pour obtenir la réponse de la structure.

3.2.2. Définition du spectre de réponse

Avant

de lancer l'analyse spectrale, il faut tout d'abord définir le spectre de réponse. Un spectre

de réponse est une courbe permettant d'évaluer la réponse d'un batiment & un séisme passé ou
futur. En Algérie le spectre de réponse est défini par le réglement R.P.A. V99 version 2003. La
figure IV.15 décrit la procédure de définition du spectre de calcul.

- Paramétres RPAQY

Enregistrer |e spectre.. =23 4

i

Aide

| Cluitter I

Systémes de contrevertement Waleurs du spectre

[ 02- Voiles porteurs ~| [pooo oise

Zones

0.010 0,184
0.020 0,180
0030 0176
0.040 072
0.050- 0162

] ¥

Groupe Site: Graph du spectre de réponse
dusage

C

I > [stStemeple -

Pourcertage d'amortissement critique

@ Portiques: @ Béton amé. @) Léger.

() Voiles ou murs {Béton amé/magonneria)

Penalités Pq

[¥] 1.Condtions minimales sur les files de cortreventement.
[¥] 2. Redondance en plan.

[ 2. Réqularité en plan. i
[] 4. Régularité en élévation. 0300 0130

[T & Cortréle de la qualité des matéra. 0320 0,130 =

[ &. Cortréle de la qualits de 'exdcution. Precision -

8810

0510

Portiques: Remplissage:

) Acier. @ Dense.

SO Lo

e

1,000 2,000 3,000 4,000 5,000 0310 0.130

{0.000-: 5.000) S m

R=350

| Q=110 | A=015 | TL=015T2=050 | £=7 n=08819

Figure 1V.15. Définition du spectre de réponse.

La définition du spectre de réponse consiste :

1.

2.
Apres

Introduire les paramétres de l'analyse spectrale (§D, Chapitre I), & savoir : le systéme de
contreventement, la zone, le groupe d'usage, la classe de site ... etc ;
Choisir un emplacement pour enregistrer le spectre de réponse sous le format " .txt ".

avoir défini tous les paramétres qui permettent de définir le spectre de réponse utilisé

pour exécuter le calcul, il est nécessaire d'introduire le spectre de réponse (figure IV.16) puis on

définit

les vecteurs directeurs du séisme (figure IV.17).

La figure IV.12 rassemble les différentes étapes qui permettent d'introduire la fonction du
spectre de réponse. Ces étapes sont résumées comme suit :

1.
2.

3.
4.
5

a s

Cliquer sur le menu principal " Define >Response Spectrum Functions ... " ;

Sélectionner, dans la liste déroulante " Spectrum From File " pour introduire la
fonction du spectre a 1'aide d'un fichier défini ;

Cliquer sur " Add New Function... " pour ajouter une nouvelle fonction ;

Spécifier le nom de la fonction du spectre ;

Spécifier la valeur du coefficient d'amortissement (§D, Chapitre I) ;

Hr
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[.Qeﬁne Draw  Select Assign  Analyze
&, Material Properties... Response Spectrum Function Definition
li-_"‘]; Frame Sections... [
& Wall/Slab/Deck Sections... — |

e Function Name 4 SPECTRE| |
!}_\ Link Properties... 8

Frame Monlinear Hinge Properties...

Cocher l'option " Period vs Value " parce que le spectre Algérien est exprimé en
fonction de la période ;

Cliquer sur " Display Graph " pour afficher 'allure du spectre de réponse ;

Cliquer sur " OK " pour créer la fonction du spectre de réponse.

{ifs Function Diamping R atio

Function File ~Walues are:-—l

Diaphragms...

; ik 7 Frequency vz Yalus
Section Cuts... Header Lines to Skip iD i s

File Mame 7 5

c:\users\cherif\desktop\spectre\specte de
rénonze. bt

. 9 % Period vs Yalue 6
I_E Response Spectrum Functions... I_ Corvert to User Defined | Wiew File !

E Time History Functions...

Funchion Graph

- Fesponze Specta——  ~ Choose Function Type toédd— it

e — SunRN
> i Add Mew Function... !I E> BN s N :

M adifysS how Specium., I

Belete Spectium _l

I 0000

10 —I 0K !] Cancel I ‘ 9—'_&_“ Cancel i

Figure 1V.16. Introduction de la fonction du spectre de réponse.

La figure IV.17 illustre les différentes étapes qui permettent la définition des vecteurs directeurs
du séisme c.-a-d. les directions d’excitation. Ces étapes sont détaillées comme suit :

1.
2.

Cliquer sur le menu principal " Define >Response Spectrum Cases ... " ;

Cliquer sur " Add New Spectrum... " pour définir le vecteur directeur du cas
sismique utilisé ;

3. Préciser le nom de la premiére composante du vecteur directeur de séisme (Ex) ;
4.
5. Pour estimer la réponse maximale de chaque degré de liberté, on doit recourir & une

Spécifier la valeur du coefficient d'amortissement (§D, Chapitre I) ;

combinaison statique des réponses modales maximales. La Combinaison Quadratique
Compléte C.Q.C. est 1'une des méthodes les plus utilisées. Cette méthode, proposée par
E.L. Wilson, A. DerKiureghian et E.P. Bayon en 1981, donne une meilleure estimation.
Cette méthode se base sur la théorie des vibrations aléatoires et donne un résultat exact
si les périodes des modes propres sont bien séparées. Pour toutes ces raisons on coche
CQC ;

Sélectionner, dans la liste déroulante le spectre défini précédemment " SPECTRE "
dans la direction " U1" puis donner le facteur d'échelle 9.81 (le facteur d'échelle
représente la valeur de 1'accélération du sol) ;

Spécifier la valeur de 'excentricité entre le centre de gravité et le centre de rigidité "Ecc
= 5% selon R.P.A. 99 Version 2003" ;

Cliquer sur " OK " pour créer la premiére composante du séisme et reprendre les étapes
2-->8 pour créer la deuxiéme composante du séisme dans la direction " U2 " ;

Aprés la définition de deux composantes de séisme on clique " OK ".

|
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| Define Draw  Select Assign  Analyee Composante du séisme Composante du séisme
Ir& Material Properties... dans la direction x-x dans la direction y-y
T Frame Sections... Response Spectrum Case Data Respense Spectrum Case Data
& Wall/Slab/Deck Sections... I
By - y @
K% Link Properties,.. ‘ Spectrum Case Name iE>¢< = 3 ‘ Spectrum Caze Mame EXT ‘
Frame Monlinear Hinge Properties... - 8 o=l
— Structural and Function D amping -—| — Structural and Function D amping —
Diaphragms... ‘ Damping iU,U? — 4 ‘ Damping IU.W
Graups.. —Madal Combination —Maodal C;I;iaou
Section Cuts., @ CQC ¢ 5RSS. © ABS O GMC 5 @ CQC ( 5ASS ¢ ABS € GMC
5] Response Spectrum Functions... i | iz | | |
fi#] Time History Functions... - Dirgctional Combination ——————————————— i~ Directional Combination
o - ' SRS & SASS
Pt B avev 8BS OrnogonalSE | 8BS DithogonalSE |
|@ R"-SF’U”?— Spectrum Cases... o 4  Modified SRSS [Chinese) + " Modified SRSS [Chinese)
o ; '”"‘tcf_-'" et ~ Input ﬁespnnsa Specta—————————————————————— ~ Input Fesponse Spectra
Static Nonlfinear/Pushover Cases.. Direction Function Scale Factor Direction  Function Scale Factor
Add Seqguential Construction Case | U1 SPECTRE " Ig ] I L1 B U1 ! ;j I

i e o T e

uz | 2 vz | =l
Spectra Click. to:
i Excitation angle !U Excitation angle ID,
£ III Add Mew Spectium I I ’
iy Show S ~ Eccentricity . ~Ececentricity
Ecc. Ratio [&ll Diaph.] 0,05 —7 Ecc. Ratio [&) Diaph.] ID,US
9 —E] Overide Diaph. Eccen. Overide. . ! Overide Diaph. Eccen: - Owerride. ..
Cancel 8 Cancel I Cancel |

Figure 1V.17. Définition des vecteurs directeurs du séisme.

3.2.3. Définition des combinaisons sismiques

L'action sismique est considérée comme une action accidentelle au sens de la philosophe de
calcul aux Etats Limites. Les combinaisons sismiques & considérer pour la détermination des
sollicitations et des déformations de calcul sont :

G+ Q=+ Exx;
G+ Q £ Eyy;
0.8G + Exx ;
0.8G £ Eyy.

Pour les ossatures autostables, les combinaisons précédentes sont remplacées par les
combinaisons suivantes :

* G+ Q=*12Exx;
* G+ Q= 1.2 Eyy.

Exx et Eyy : sont les composantes horizontales du séisme. La figure IV.18 rassemble les
différentes instructions qui permettent la définition des combinaisons sismiques.
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| Define Draw  Select  Assign  Analyre

& Material Properties... - Combinations - | Dlick tor = '

“-_"'1* Erame Sections... ELS :2 —m‘ l

= Wall/Slab/Deck Sections... ELL

5E Link Properties.. gggﬁ Madify/Show Comba.. |
. DEGEX

Frame Monlinear Hinge Properties...

N8GEYY [elete Combo l

Erougs.., . Cancel !

Section Cuts.. J

E Response Spectrum Functicns..
B Time History Functions...

& Static Load Cases.. | Load Combination Hame 3 —IiGuEXX I
[~ Response Spectrum Cases...
Bfl Tirne Hictony Casec.; Load Combiration Type ADD b
Static Monlinear/Pushover Cases... i~ Define Combination ﬁ
Add Sequential Construction Case 4 Case Mame Scale Factor
= EYY Spect it i
IiEM Load Combinations,,, je— 1 .pec = . |
= 5 Static Load 1 badify i
Add Default Decsign Combos.., @ Static Load 1 5
Convert Combes to Monlinear Cazes.., Réednecha L Delete l

Special Seismic Load Effects...
< = | ?— (0] 4 || Cancel I

@ Mass Source..

Figure IV.18. Définition des combinaisons sismiques.

Les instructions de la figure IV.18 peuvent étre détaillées comme suit :

Cliquer sur le menu principal " Define >Load Combinations ... " ;

Cliquer sur " Add New Combo... " ;

Spécifier le nom de la combinaison ;

Spécifier le cas de chargement ;

Saisir le coefficient de majoration ;

Cliquer sur " Add " puis reprendre les étapes 3, 4, 5 et 6 pour ajouter les autres
combinaisons de charge ;

7. Cliquer sur " OK " pour confirmer la création de la combinaison ;

8. Cliquer sur " OK " apreés la définition de toutes les combinaisons de charges.

SO N

Aprés avoir défini toutes les combinaisons sismiques, on lance le calcul du modéle a partir du
menu principal " Analyze >Run Analysis " ou par la touche " F5 " du clavier.

La prochaine étape consiste & visualiser et exploiter les résultats de 'analyse

4. Exercice

Prenant la structure illustrée sur la figure 11.23 (Chapitre II, § 3). Sachant que la structure précédente
sera implantée au niveau de la wilaya de Boumerdes sur un sol de type S4 ;

1. Vérifier les différents critéres de qualité de la structure (régularité en plan, régularité en élévation
... ete.) selon le réglement RPA 99 V2003.

2. Définir et introduire le spectre de réponse selon le réglement RPA 99 V2003.

3. Insérer les voiles de contreventement de fagon que les deux premiers modes de vibration soient une
translation.

4. Définir les combinaisons de charges sismiques selon le réglement RPA 99 V2003.

I
|
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CHAPITRE .V.
VISUALISATION ET
EXPLOITATION
DES RESULTATS
DU CALCUL

Tableaux de résultats 56
Présentation graphique des résultats 65
Exercice 68

Pour un logiciel de calcul de structures, un des points les plus importants est l'exploitation des
résultats. Dans ce domaine, ETABS nous propose des outils trés performants. Sous forme graphique
ou de tableaux, la gamme d'exploitation est trés compléte. Parmi ses différentes fonctionnalités, on
peut noter : l'analyse graphique, détaillée ou globale ainsi que les cartographies pour les éléments
surfaciques et les résultats réduits pour les panneaux, ... etc.

Le multi-fenétrage d'"ETABS permet d'isoler un certain nombre d'éléments d'une structure complexe
afin d'obtenir des résultats affinés sur cette partie. Cela permet en outre d'afficher les différents
types d'affichage de résultats disponibles simultanément a 1'écran (tableau de données, cartographie,
ete..).

Dans ce qui ce suit nous présenterons les différentes instructions qui permettent 1'affichage de
différents résultats de calcul.

1. Tableaux de résultats

Les tableaux présentent les différents résultats de calculs de la structure (déplacements, contraintes,
efforts, réactions aux appuis, etc...). Les tableaux sont affichés a 1'écran en cliquant sur le menu
principal " Display >Show Tables ".

1.1. Déplacements du centre de masse

Pour afficher les déplacements, du centre de masse, engendrés par les composantes du séisme, on
doit effectuer les opérations suivantes :

n

1. Cliquer sur le menu principal " Display >Show Tables " ;

2. Cocher l'option " Displacements " ;

3. Cliquer sur la commande " Select Cases/Combos...
combinaisons et des cas de charges ;

4. Choisir les cas de charges sismiques (Exx et Eyy) ;

5. Cliquer sur " OK " pour confirmer la sélection des cas de charges sismiques ;

6. Cliquer sur " OK " pour afficher le tableau des déplacements du centre de masse.

" pour afficher la liste des

Les figures V.1 et V.2 illustrent les instructions qui permettent l'affichage du tableau de
déplacements.
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Choose Tables for Display
Edit

&[] MODEL DEFINITION [0 of 65 tables selected) - Load Cases (Modsl Det ] ——

Eil:l Building D ata Select Load Cases . i

Display Design Options  Help ED Property Definitions | 2 of 2 Loads Selected
| #-[] Load Definitions :
1 Show Undeformed Shape ED Point Assignments 3 ~Load Cazes/Combos [Results]
ShowLoads 4 &0 Frame Assignments ? | Select Cases/Combos...

& #-[0 Area Aszsignments
FF Show Deformed Shape... E!I:I Input Design Data 10 of 10 Loads Selected

£ Show Mode Shape... Bil:l Design Overwrnites Madify/Show Options. . i

H Show Member Forces/Stress Diagram » ED Options/Preferences Data L : Al
= [ Miscellaneous Data —
ff Show Energy/Virtual Work Diagram...

=

SULTS [7 of 26 tables selected]

Select Cutput

Bil:l Modal Information ~Selest———— g
B':! [ Building Dutput 08GE»2< Combo
&[] Frame Output 0BGEYY Combo | |

Show Story Response Plots.. &[] Area Dutput | =

B &-[] Objects and Elements | ~Mamed Sets -
Show Tables... I_
I = 1 . A 2 Cancel ! Save Mamed Set... i

NG Load
GLEX Combo
GEEYY Comba
0 Static Load

, | Cleaan |

Figure V.1. Visualisation des déplacements du centre de masse.

Edit Wiew _

| Diaphragm CM Displacements. =l
Story Diaphragm Load UX Uy Uz
b | STOR¥I-S ot | e 00118 00000 | | 00000
_STORY1-S i VY 0,0000 0,0108 0,0000
_STORY1-4 o EXX 00104 | | | opoo0 0,0000
STORY1-4 D1 EYY - 0.0000 | o009z | 0,0000
STORY1-3 D EXX 0,008 | 00000 0,0000
STORY1-3 ot By 40000 | 0.0073 0,0000
ETORY -2 D1 XX 0,0083 oo000 | 0,0000
STORY1-2 o1 By 0,0000 | 0,0052 0,0000
_STORY1-1 ot B og040 | | | oo000 | 0,0000
STORY -1 b1 VY 0,0000 00031 0,0000
STORYT b EXX 0,007 10,0000 0,0000
STORY1 o1 EYY 04,0000 | 00012 | 0000
BASE o1 BN g,0000 | g.0000 | 0,0000
BASE D1 EYY o,0000 | 0,0000 0,0000

I
Ll | Colonne  Colonne :
A B
[IENAL] o]

Figure V.2. Valeurs de déplacements du centre de masse.

La figure V.2 montre les valeurs de déplacements du centre de masse pour tous les étages.
D'aprés ce tableau, on remarque ce qui suit :

® La colonne " A " représente les déplacements engendrés par la composante sismique "

Exx " dans la direction " X-X " ;
® La colonne " B " représente les déplacements engendrés par la composante sismique
Eyy " dans la direction " Y-Y " ;

n
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1.2. Réactions d'appuis

Les réactions d'appuis permettent de dimensionner et calculer les fondations de la structure. Le
figure V.3 regroupe les différentes étapes qui permettent l'affichage des réactions d'appuis.

Select  Assign  Apalyze

at Pointer/in Window
xﬁ% Intersecting Line

on XY Plane

on XZ Plane

on ¥Z Plane

by Groups...

by Frame Sections...

by Wall/5lab/Deck Sections...

by Link Properties...

by Line Object Type...

by Area Object Type...

by Pier ID..

by Spandrel ID...

by Story Level

Y

Display

~Select-

2

1 '
Cancel

Clear 8|

Choose Tables for Display

Edit

E

=[] MODEL DEFINITION (D of 65 tables selected]
& [ Building Data
#-[] Property Definitions
E!D Load Definitions
&[] Point Assignments
E!D Frame Assignments
E!D Area Assignments
&[] Input Design Data
E!D Deszign Overwrites
&-[] Options/Preferences Data
#-[] Miscellaneous Data

E

=@ ANALYSIS RESULTS (7 of 26 tables selected)
&[] Displacements

 Load Cases [Model Def.)

Select Load Cases... I

| 2 of 2 Loads Selected

~ Load Cages/Combos [Fesults]

4 Select Cazes/Combios... |

|10 of 10-Loads Selected

Modify/Show Options.... I

— Dptiong-

&

i~ Mamied Sets -

- Select Output
- Reactions 3 it iy
-] Modal Information
&0 Building Output 5
#-[] Frame Output
&-[] Area Output
-] Wall Dutput
#-[] Objects and Elements |
Cancel 1
[ Static Load
Clear 4l |

Save Mamed Set.. i
Shiews Mamed Setbi;
| Cancel !

Figure V.3. Visualisation des réactions d'appuis.

Les instructions de la figure V.3 peuvent étre expliquées comme suit :

1. Cliquer sur le menu principal " Select >By Stroy Level " pour sélectionner les points
d'appuis de la structure ;
2. Choisir le niveau " BASE " ;
3. Cliquer sur le menu principal " Display >Show Tables " puis cocher 1'option "
Reactions " ;
4. Cliquer sur la commande " Select Cases/Combos... " et choisir la combinaison E.L.S.
(Généralement le dimensionnement des fondations s'effectue a I'E.L.S.) ;
5. Cliquer sur " OK " pour confirmer la sélection de la combinaison E.L.S. ;
6. Cliquer sur " OK " pour visualiser le tableau des résultats, les réactions d'appuis sont
consignées dans la colonne " A " (Voir figure V.4).
Edit View
| Support Fieactions -]
Point FX FY FZ 4]
» it 0,18 7,86 315
z 0,04 0,03 5848 |
3 0,07 0,00 5597
4 -0,07 0,00 = 0,000
5 0,18 706 3515 0
T i 1292 0,00 B4 Tir 10,000 0001
8 | HS 024 0,00 B2 6,000 0,000
g |[lets 0,14 0,01 T 0 0,000 0,000
1‘:’: L5 0,04 0,08 708 0,000 0,000 0,000
42 | Eis | o8 0,05 8847 0,000 0,000 0,000
3 L5 6,09 0,08 66,47 0,000 0,000 0,000
i 44 | Eis 0,14 0,01 7483 0000 0,000 {
_ BASE 15 ELS 024 000 5742 0,000 0,000
i
Colonne A

Figure V.4. Valeurs des réactions d'appuis a I'E.L.S.
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1.3. Résultats de 1'analyse modale spectrale

Les résultats de 1'analyse modale spectrale peuvent étre visualisés en effectuant les opérations
illustrées sur la figure V.5. Ces opérations sont détaillées comme suit :

SO W=

Dlgglay_ Design  Options  Help
[1 Show Undeformed Shape
Show Loads ¥

7 Show Deformed Shape...
ﬁ Show Mode Shape...
M Show Member Forces/Stress Diagram #

% Show Energy/Virtual Work Diagram... ‘
[~

Show Story Response Plots...

I Show Tables.. I_ 1

Cliquer sur le menu principal " Display >Show Tables " ;
Cocher les options " Modal information " et " Building Output " ;
Cliquer sur la commande " Select Cases/Combos... " pour choisir les cas de charges ;
Sélectionner les cas de charges sismiques (Exx et Eyy) ;
Cliquer sur " OK " pour confirmer la sélection des cas de charges sismiques ;

Cliquer sur " OK " pour visualiser le tableau de résultats de 1'analyse modale spectrale.

Choose Tables for Display

Edit

=-[0 MODEL DEFINITION (O of 65 tables selected)
&[] Building Data

&[] Property Definitions

ED Load Definitions

&[] Point Assignments

ED Frame Assignments

i-[] Area Assignments

H':! O Input Design Data

&[] Design Dverwrites

H':! [0 Options/Preferences Data

#-[] Miscellaneous Data

E AMALYSIS RESULTS [7 of 26 tables selected)
E!D Dizplacements
i-[1 Beactions

Select Cutput

— Select-
08GE< Combo
08GEYY Comba
ELS Combo

- Modal Information
E! B Building Dutput
#-[] Frame Output
H':! O Area Output
&[] Objects and Elements

F k| Ahc Load
GOEX Combo

GOEYY Combo

0 Static Load

Cancel J

- Load Cases [Model Def. | ——

Select Load Cases...

2 of 2 Loads Selected

- Load Cazes/Combos [Resultz)

Select Cases/Combos..

10 of 10 Loads Selected

Modify/Show Options. ..

-~ Optionz -

—Mamed Sets -

Save Mamed Set... 1

| Clear Al ]

Canicel

Figure V.5. Visualisation des résultats de l'analyse modale spectrale.

Les étapes de la figure V.5 permettent 1'affichage d'un tableau qui regroupe :

renversement.

La masse de chaque étage ;

Les coordonnées du centre de masse ;

Les coordonnées du centre de rigidité ;

Le taux de participation des masses modales ;
Les périodes naturelles des modes propres ;
La distribution des efforts tranchants au niveau des étages ainsi que le moment de

1.3.2. Coordonnées des centres de masse et de rigidité

Les coordonnées des centres de masse et de rigidité peuvent étres affichées en cliquant sur la
commande 1 de la figure V.6 puis on sélectionne dans la liste déroulante

Rigidity ". Le tableau " Center Mass Rigidity " montre :

La colonne " A " regroupe la masse de chaque étage de la structure ;

® La colonne " B
structure ;

® La colonne " C
structure.

regroupe les coordonnées du centre de masse des

regroupe les coordonnées du centre de rigidité des

EEEE
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Edit  View
Story Diaphragm MassX MassY | XCM | YCM | CumMassX [ CumMassY HCCM YCCM XCR YCR
» | EBrorvis ot 15,0916 | | 15,0916 | 10506] 5,049 | 150916 15,0016 10,506 5,049 10,500 4829
: D1 16,1724 | | 16,1224 | 10,506 5060 | 312740 31,2140 10,506 5,054 16,500 4355
o1 16,1224 | [ 161224 [10506| 5060 | 47,3364 47,3364 10,506 5,056 10,500 4889
D1 16,1224 | | 16,1224 [ 10,506 5,060 | 634588 63,4588 10,508 5,057 10,500 4942
D1 16,1224 | | 16,1224 | 10506 5060 | 79,5812 79,5812 10,506 5,058 10,500 5,034
] 16,5943 | | 16,5043 [ 10506] 5084 | 951755 96,1755 10,506 5,050 10,500 5,194
Colonne Colonne Colonne
A B Cc
TIRNSC]

Figure V.6. Coordonnées de centre de masse et de centre de rigidité.

1.3.3. Nombre de modes a considérer

Les périodes, le taux de participation des masses modales et le taux de torsion peuvent étres
affichés en cliquant sur la commande 1 de la figure V.7 puis on sélectionne dans la liste
déroulante " Modal Participating Mass Ratios ". Le tableau " Modal Participating
Mass Ratios " montre :

® La colonne " A " qui regroupe les périodes naturelles de chaque mode propre ;
* La colonne " B " qui regroupe le taux de participation des masses modales ;
® La colonne " C " qui regroupe le taux de torsion pour chaque mode propre.

Edit  View

1 ==t \idal Participating Mass Fatios || _:_J

Mode Period Ux Y Uz SumUX | SumUY SumbZ SumRX | SumBY | SumRZ
» 1 0533968 | | 795931 | ‘00000 | oooo0 | 7oe831 | 0,0000 . 0,000 00000 | 998373 | 80353
2 0,494793 | | 00000 | 753735 | 00000 796931 | 763736 00000 937515 | 996373 | 00353
= 0361430 | | 00494 | ‘00001 | oD00OO 787425 | 783737 0,0000 952517 | 88,6808 | 75,8080

4 || 0149314 | |12,9075 | 0,0000 | 00000 | 828500 | 76,3737 00000 | 883517 | 88,7278 | 755123

I 5 N1 oizesez | | 00000 | 150214 oooo0 | | a26500 | 91.3051] 00000 | 99586 | suzre | 759123
G 0,091708 00000 | 826515 | 91,3951 00000 | 996386 | 99,7278 | 91,1657

‘7 || 0088500 | | 45448 0,0000 | 971963 | 913951 0,000 99,6588 | 98,9572 | 91,1672
8 0054084 | | 0 00000 | 971963 | 965710 0,0000 939287 | soos72 | o1e72
Colonne A Colonne B Cnlonmla C

T [ o ]

Figure V.7. Nombre de modes a considérer.

Il faut bien comprendre qu'il n'est pas nécessaire de considérer 1'effet de tous les modes de
vibration pour obtenir une précision acceptable dans les structures de génie civil. Pour modéliser
un batiment en trois dimensions, le nombre de modes requis dans une analyse dynamique
modale spectrale dépend de la direction de l'excitation & la base et du degré de couplage entre
les modes de translation et les modes de torsion. Le réglement R.P.A 99 V2003 utilise la masse
modale comme un indicateur du nombre de modes & considérer dans 1'analyse. Le nombre de
modes a employer doit étre suffisant pour représenter au moins 90% de la masse totale de la
structure. Dans notre cas, la masse modale dépasse le taux de 90% a partir du cinquiéme mode

(Voir figure V.7). De ce fait, le nombre de modes a considérer est égal a 5.

1.3.4. Distribution des efforts tranchants

Les efforts tranchants de chaque étage peuvent étres affichés en cliquant sur la commande 1 de
la figure V.8 puis on sélectionne dans la liste déroulante " Story Shears ". Le tableau " Story
Shears " montre :

® La colonne " A " qui regroupe les efforts tranchants a chaque étage de la structure ;
® La colonne " B " qui regroupe les moments de renversements engendrés par les efforts
tranchants au niveau de chaque étage.

X
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Colonne A ColonneB

eI

Figure V.8. Distribution des efforts tranchants sismiques.

1.4. Résultats des éléments barres

Pour les structures & barre dans ETABS, il est possible d'afficher les résultats des éléments
barres dans un tableau résumant leurs efforts internes. Avant d'afficher les résultats des
éléments barres, il faut tout d'abord sélectionner les éléments appropriés (soit : poteaux, poutres
... etc.) puis présenter leurs résultats. Les figures V.9 et V.10 illustrent les étapes qui permettent
la visualisation des efforts internes des éléments barres.
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Figure V.9. Visualisation des résultats des éléments de barres.

Les opérations de la figure V.9 peuvent étre détaillées comme suit :

1.
2.

3.

Cliquer sur le menu principal " Select >By Frame Sections... " ;

Sélectionner la section des éléments désirés, par exemple les poutres PP30x45 et les
poteaux POT30x45 ;

Cliquer sur " OK " pour confirmer la sélection des éléments précédents ;

Cliquer sur le menu principal " Display >Show Tables " puis cocher l'option
Frame Output " ;

Cliquer sur la commande " Select Cases/Combos...
E.L.U. et les combinaisons sismiques ;

Cliquer sur " OK " pour confirmer la sélection des combinaisons précédentes ;

Cliquer sur " OK " pour visualiser le tableau des efforts internes des éléments barres
(Voir figure V.10).

"

" puis choisir la combinaison
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Beam Forces R i ’ i % y =
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Figure V.10. Tableaux des efforts internes des éléments de barre.

Les efforts internes au niveaux des éléments barres peuvent étres affichés en cliquant sur la
commande 1 de la figure V.10 puis on sélectionne dans la liste déroulante la nature de 1'élément
barre, c.-a-d." Beam Forces " pour le cas des poutres et " Column Forces " pour les cas
des poteaux. Le tableau des efforts internes montre :

® La colonne " A " qui regroupe les points intermédiaires sur la barre pour lesquels le
tableau affiche les valeurs des efforts internes ;

® La colonne " B " qui regroupe les efforts tranchants au niveau des points intermédiaires ;

® La colonne " C " qui regroupe les moments fléchissants au niveau des points
intermédiaires.

1.5. Résultats des éléments plaques

Pour afficher les résultats des éléments plaques, on doit tout d'abord choisir un axe comportant
un élément surfacique puis on suit les étapes de la figure V.11. Ces étapes sont détaillées comme
suit :

1. Sélectionner un voile a 1'aide du bouton droit de la souris ;

2. Cliquer sur le menu principal " Assign >Shell Area >Pier Label... " ou par l'icone
figurée dans l'espace de travail. Cette instruction permet d’obtenir la résultante d'efforts
a la base du voile ;

3. Choisir l'option " P1 " pour attribuer l'option " Pier Label "au voile ;

4. Cliquer sur " OK ".

n

-
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Figure V.11. Sélection des voiles.

Aprés avoir affecté 1'option " Pier Label "au voile, on procéde a exploiter les résultats des
efforts internes de 1'élément surfacique (Voir figure V.12).

Choose Tables for Display

Edit

E O Input Design

#-[] Reactions

EHI] Area Dutput
#-6 Wall Output §

g-0 MODEL DEFIMITION [0 of 65 tables zelected)
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ED OptionsfPreferences Data
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5-E ANALYSIS RESULTS (7 of 26 tables selected] [ Selection Daly

EEEI Displacements
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&[] Frame Dutput

#-[] Objects and
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~ Load Cazes [Model Def.]-

Select Load Cases... ]
2 of 2 Loads Selected
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GEY
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Cancel

Cancel

Static Load
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Clear All

Figure V.12. Visualisation des efforts internes des éléments de plaque.

Les opérations de la figure V.12 peuvent étre détaillées comme suit :

1. Cliquer sur le menu principal " Display >Show Tables

Output " ;

" puis cocher 1'option " Wall
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2. Cliquer sur la commande " Select Cases/Combos... "

E.L.U. et les combinaisons sismiques ;
3. Cliquer sur " OK " pour confirmer la sélection des combinaisons précédentes ;
4. Cliquer sur " OK " pour visualiser le tableau des efforts internes au niveau du voile

puis choisir la combinaison

choisi (Voir figure V.13).

Edit  View
Story Pier Load Loc M3

b | stomvt | P ELU Top 4584
STORY1 | P1 ELU Bottom 2993
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STORY1 | P1 | GQEXIMIN ‘Bottom 471,488
STORY Pt GQEY Y MAX Top ~&1,40 5,398
SToRY1 | P1 | GOEWY MAX | Battem 4548 40,563
STORYT | P1 | GOEYY MM Top BT 1,210
STORY1 | P1 | GOEYYMN |  Hottom 85,79 -3,766
STORY1 | P1 | DBBEXCCMAX Top 2957 4,187
STORY1L | P1 [ 0BGEXXMAX |  Bottom 25,84 0339
STORY1 | P1 | DEGEXXMMN Top 62,88 0,000
STORYA | Pi | D2CEN MM ‘Bottom 86,15 0,138 -2963
STORYA Pt | DBGEYY MAX Toip ZFET 0,547 4187
STORYY P1 | 0BGEYY MAX ‘Battom -25,84 0,139 0239
STORYT | P1 | 0BGEVY MIN Top 8288 -0.564 0,000
ST0RY1 | P1 [ 0BGEYYMIN |  Bottom 86,15 : -0,138 2,963

IR Colonne/ﬁ: Colonne B Colonne C

Figure V.13. Tableaux des efforts internes des éléments de plaque.

Les efforts internes & la base du voile sont consignés dans le tableau de la figure V.13. Le
tableau d'efforts internes montre :

® La colonne " A " regroupe les efforts normaux & la base du voile ;
® La colonne " B " regroupe les efforts tranchants a la bases du voile ;
® La colonne " C " regroupe les moments fléchissants & la base du voile.

2. Présentation graphique des résultats

Pour les structures modélisées par ETABS, il existe plusieurs possibilités d'afficher les résultats sous
forme graphique. Les options de base a utiliser lors de la présentation des résultats sont :

® Les diagrammes d'efforts internes ;
* La déformée de la structure ;
® Les cartographies sur les plaques.

2.1. Diagrammes des efforts internes

Pour visualiser les diagrammes des efforts internes, il suffit de suivre les étapes suivantes :

1. Cliquer sur le menu principal " Display >Show Member Forces/Stress Diagram "

2. Cliquer sur " Frame/Pier/Spandral Forces... " ;

3. Choisir la combinaison désirée, par exemple I'E.L.U. ;

4. Choisir la nature du digramme a afficher soit : effort normal ( Azial Force ), effort
tranchant ( Shear 2-2 ou 3-3 ) ou moment fléchissant ( Moment 2-2 ou 3-3 ) ;

5. Cocher l'option " Show Values on Diagram ", cela permet d'afficher les valeurs
maximales et minamales sur le diagramme & visualiser ;

6. Cliquer sur " OK " pour visualiser le diagramme des efforts internes au niveau du
portique choisi (Voir figure V.14).
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Figure V.14. Visualisation du digramme des efforts internes.

2.2. Déformée de la structure

Pour visualiser les diagrammes des efforts internes, il suffit de suivre les instructions suivantes :

n

1. Cliquer sur le menu principal " Display >Show Deformed Shape... " ;

2. Choisir la combinaison désirée, par exemple 'E.L.U. ;

3. Cliquer sur " OK " pour visualiser la déformée de la structure sous l'action de la
combinaison choisie (Voir figure V.15).

Display Design Options  Help Ll Elevation View - 2 Deforred Shape (ELU)
[l Show Undeformed Shape
Show Loads (3

I?T Show Deformed Shape.., |—1
ﬁ Show Mode Shape...
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,5/ Show Energy/Virtual Work Diagrarm...

Show Story Response Plots..

Show Tables...

Detormed Shep< I

-: - Szaling :
* Auto 2

{" Scale Factor J
¥ Cubic Curve

3 ok | Cancel |

Figure V.15. Visualisation de la déformée de la structure.
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2.3. Cartographie sur les plaques

L'option cartographie sert a éditer une représentation couleur des contraintes, déformations,
efforts internes etc. obtenus lors de 1'analyse des éléments de type plaque. L'option cartographie

pour les plaques est accessible & partir du menu principal " Display

". Pour afficher la

cartographie des éléments plaques, il suffit de suivre les étapes de la figure V.16.
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Show Loads [ 4

7 Show Deformed Shape...
ﬁ Show Mode Shape..
ﬁi SHow WG Sl Rl Support/Spring Reactions...

ﬁ Show Energy/Virtual Work Diagram...
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— Component Type -|
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& F22 M2z w2 4
Rz M2 7 kAR
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" MMIN

P iﬂ_- P an !U_‘
~ Shess Averaging =
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7 atallJaints
i at Selected Elements Set Groups.. !
[ Display on Defarmed Shape
5 k. l Cancel j

Figure V.16. Visualisation de la cartographie des éléments de plaques.

Les étapes illustrées sur la figure V.16 peuvent étre détaillées comme suit :

1. Cliquer sur le menu principal " Display >Show Member Forces/Stress Diagram

>Shell Stresses/Forces... " ;

2. Sélectionner la combinaison désirée, par exemple 'E.L.U. ;
3. Sélectionner la nature de la cartographie & afficher c.-a-d. cartographie de forces ou de

contraintes ;

4. Dans cette boite on peut sélectionner la directions des efforts normaux, des moments
fléchissants , et des ou des efforts tranchants dans laquelle la cartographie de forces ou de

contraintes sera affichée ;

5. Sélectionner Cliquer sur " OK " pour visualiser la cartographie des voiles sous l'action de

la combinaison E.L.U. (Voir figure V.17).
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Figure V.17. Cartographie des sollicitations et de contraintes.

3. Exercice

Prenant la structure illustrée sur la figure I11.23 (Chapitre II, § 3). Utiliser les différentes commandes
d'ETABS pour :

1.

o

Déterminer les déplacements du centre de masse au niveau de chaque étage composant la
structure.

2. Déterminer les valeurs d'excentricité entre le centre de masse et le centre de rigidité.
3.
4. Déterminer les valeurs maximales des efforts internes (effort normal, effort tranchant et moment

Déterminer la valeur maximale des réactions d'appuis a I'ELS et a I'ELU.

fléchissant) au niveau des poteaux et des poutres.
Déterminer les efforts réduits des voiles de contreventement au niveau du Rez-De-Chaussée.

Visualiser la déformée de la structure sous l'action des combinaisons sismiques.



Exercice

Soit la structure illustrée sur la figure (a).

g
iy
[
® ® © ®
Plancher Plancher Plancher i
D4~ - :3
Plancher vide | Plancher | = &
G- S -
Plancher Plancher Plancher | 7
R e S—— |
| 8m | 6m S m | Z 7 Z Z
| 1 | @ @) @ @
Figure (a)

La structure ci-dessus est un parking de stationnement public, composé d'un Rez-De-Chaussée, 7
étages identiques et un toit. Cet immeuble sera implanté a la wilaya de Constantine, cette région est
classée comme une zone de moyenne sismicité (zone II.a) selon la classification des zones établie par le
réglement parasismique Algérien 99 version 2003. Le batiment étudié présente les caractéristiques
suivantes :

® Selon la classification des ouvrages suivant leur importance d'aprés le réglement parasismique
Algérien, le groupe d'usage est le "groupe 2" ;

® Selon la zone sismique et le groupe d'usage du batiment, le coefficient d'accélération de zone "A"
est égal a 0.15 ;

* Le contreventement de la structure est assuré par un noyau centrale, d’ou la valeur du
coefficient de comportement "R" est égale & 3.5 ;

* La configuration du batiment étudié ne satisfait pas les conditions minimales sur les files
de contreventement ;

* Des essais systématiques sur les matériaux mis en ceuvre seront réalisés par 1'entreprise pour
controler la qualité des matériaux utilisés ;

® Une mission de suivi sur chantier est chargée pour contréler la qualité d'exécution des
travaux ;

® Selon les critéres de qualité, le facteur de qualité Q vaut 1,1 ;

Selon 1'étude géotechnique, le sol est classé dans la catégorie S1 (sol rocheux) ;

Le pourcentage d'amortissement critique € est égal & 7% ;

L'acier utilisé est de nuance FeE 500 ;

Le béton utilisé est le B35 ;

Les planchers utilisés sont des dalles pleines d'épaisseur de 30 cm ;

La section des poteaux est égale & 60x60 cm? ;

Les voiles du noyau ont une épaisseur de 30 cm ;

Les poutres porteuses qui agissent dans les directions x-x et y-y ont une section de 30X 65
cm?.

On demande de :

TEEED



® Déterminer les valeurs de la charge d'exploitation selon le Document Technique Réglementaire
DTR BC 2.2.

® Vérifier la configuration du batiment vis-a-vis la régularité en plan et en élévation.

* Déterminer les déplacements du centre de masse au niveau de chaque étage composant la
structure.

® Déterminer les valeurs d'excentricité entre le centre de masse et le centre de rigidité.

* Déterminer la valeur maximale des réactions d'appuis a I'ELS et a I'ELU.

* Déterminer les valeurs maximales des efforts internes (effort normal, effort tranchant et moment
fléchissant) au niveau des poteaux et des poutres.

® Déterminer les efforts réduits du noyau de contreventement au niveau du Rez-De-Chaussée.

* Visualiser la déformée de la structure sous l'action des combinaisons statiques et sismiques.
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Ressources annexes

Abréviations

C.A.O. : Conception Assistée par Ordinateur

C.B.A. 93 : régles de Conception et de calcul des structures en Béton Armé 93
C.Q.C. : Combinaison Quadratique Compléte

C.S.A.O. : Calcul de Structures Assisté par Ordinateur

D.A.O. : Dessin Assisté par Ordinateur

D.T.R. BC 2.2 : Document Technique Réglementaire BC 2.2

E.L.S. : Etat Limite de Service

E.L.U. : Etat Limite Ultime

ETABS : Extended Three-dimensional Analysis of Building Systems
M.E.F : Méthode des Eléments Finis

R.P.A. 99 V2003 : Réglement Parasismique Algérien 99 Version 2003
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